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1 The Journal Information

1.1 Contact Information

DavidRM Software

http://www.davidrm.com

Mailing Address:

DavidRM Software

112 East 54th Street
Tulsa, OK 74105
United States of America

The Journal Home Page
http://www.davidrm.com/thejournal/

The Journal Customer Support, Bug Reports & Suggestions
davidrm@davidrm.com

Have a question? A suggestion? Just want to say "Hi!"? Send me an email!

The Journal Newsletter
http://groups.yahoo.com/group/thejournal-newsletter
http://www.davidrm.com/thejournal/newsletter/

The Journal User Discussion
http://groups.yahoo.com/group/thejournal-users

1.2 THE JOURNAL - PRODUCT LICENSE INFORMATION

NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT.

USE OF THE SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE")
CONSTITUTES YOUR ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE
TERMS OF THIS AGREEMENT, DO NOT INSTALL AND/OR USE THIS SOFTWARE.

1. LICENSE GRANT.

DavidRM Software grants you a license to use one copy of the version of this SOFTWARE on any one
hardware product for as many licenses as you purchase. "You" means the company, entity or individual
whose funds are used to pay the license fee. "Use" means storing, loading, installing, executing or
displaying the SOFTWARE, whether on the hardware product directly or via a network.

Individuals (not companies nor other entities) who purchase the SOFTWARE may use the
SOFTWARE on one additional hardware product, for a total of two hardware configurations. In this
case, however, the individual must be the only user of the SOFTWARE on both hardware products.

When you first obtain a copy of the SOFTWARE, you are granted an evaluation period of not more
than 45 days, after which time you must pay for the SOFTWARE according to the terms and prices
discussed in the SOFTWARE's documentation, or you must remove the SOFTWARE from your
computer.

You may not modify the SOFTWARE or disable any licensing or control features of the SOFTWARE
except as an intended part of the SOFTWARE's programming features.

© David Michael. All Rights Reserved.
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This license is not transferable to any other hardware product or other company, entity, or individual.
2. OWNERSHIP.

The SOFTWARE is owned and copyrighted by DavidRM Software. Your license confers no title or
ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

3. COPYRIGHT.

The SOFTWARE is protected by United States copyright law and international treaty provisions. You
acknowledge that no title to the intellectual property in the SOFTWARE is transferred to you. You
further acknowledge that title and full ownership rights to the SOFTWARE will remain the exclusive
property of DavidRM Software and you will not acquire any rights to the SOFTWARE except as
expressly set forth in this license. You agree that any copies of the SOFTWARE will contain the same
proprietary notices which appear on and in the SOFTWARE.

4. UNAUTHORIZED USE.

You may not use, copy, rent, lease, sell, modify, decompile, disassemble, otherwise reverse engineer,
or transfer the SOFTWARE except as provided in this agreement. Any such unauthorized use shall
result in immediate and automatic termination of this license.

5. U.S. GOVERNMENT INFORMATION.

Use, duplication, or disclosure by the U.S. Government of the computer software and documentation in
this package shall be subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in
Technical Data and Computer Software clause at DFARS 252.277-7013 (Oct 1988) and FAR 52.227-
19 (Jun 1987). The Contractor is DavidRM Software, 112 East 54th Street, Tulsa, OK, 74105.

6. LIMITED WARRANTY.

THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. DAVIDRM SOFTWARE DISCLAIMS ALL
WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED,
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. NEITHER DAVIDRM SOFTWARE NOR ANYONE ELSE
WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS
SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE, EVEN IF
DAVIDRM SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR
CLAIMS. THE PERSON USING THE SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND
PERFORMANCE OF THE SOFTWARE.

SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF INCIDENTAL OR
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSION MAY NOT APPLY
TO YOU TO THE EXTENT THAT LIABILITY IS BY LAW INCAPABLE OF EXCLUSION OR
RESTRICTION.

IN NO EVENT SHALL ANY THEORY OF LIABILITY EXCEED THE LICENSE FEE PAID TO
DAVIDRM SOFTWARE.

7. NO LIABILITY FOR CONSEQUENTIAL DAMAGES.

IN NO EVENT SHALL DAVIDRM SOFTWARE OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY
CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT DAMAGES OF ANY KIND ARISING OUT
OF THE DELIVERY, PERFORMANCE OR USE OF THE SOFTWARE, EVEN IF DAVIDRM
SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT
WILL DAVIDRM SOFTWARE'S LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT OR
ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

© David Michael. All Rights Reserved.
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8. SEVERABILITY.

In the event of invalidity of any provision of this license, the parties agree that such invalidity shall not
affect the validity of the remaining portions of this license.

9. GOVERNING LAW.

This agreement shall be governed by the laws of the State of Oklahoma excluding the application of its
conflicts of law rules and shall inure to the benefit of DavidRM Software and any successors,
administrators, heirs and assigns. Any action or proceeding brought by either party against the other
arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of
competent jurisdiction located in Tulsa County, Oklahoma. The parties hereby consent to in personam
jurisdiction of said courts. This agreement will not be governed by the United Nations Convention on
Contracts for the International Sale of Goods, the application of which is expressly excluded.

10. ENTIRE AGREEMENT.

This is the entire agreement between you and DavidRM Software which supersedes any prior
agreement or understanding, whether written or oral, relating to the subject matter of this license.

11. RESERVED RIGHTS.

All rights not expressly granted here are reserved to DavidRM Software.
1.3 Credits

The Journal was designed and developed entirely by David Michael.

The Journal was developed using Borland Delphi (http://www.borland.com/delphi).

The Journal's online help was created with Help & Manual from EC Software
(http://www.helpandmanual.com).

The Journal's original Calendar Charm icons (& #® € ) were created by Dan MacDonald. Additional
Calendar Charms were created by Jennifer Holstien and Mickael Pointier.

The Journal uses the following third-party algorithms and components:

TRichViewEdit component by Sergey Tkachenko (http://www.trichview.com).

DBISAM database components by Elevate Software (http://www.elevatesoft.com).
Configurable menu and toolbars from Developer Express (http://www.devexpress.com).
Spell checker and thesaurus from Addictive Software (http://www.addictivesoftware.com).
MD5 (password hashing) algorithm produced by RSA Data Security, Inc.

Twofish block cipher (entry text encryption) designed by Bruce Schneier
(http://www.counterpane.com).

Twofish encryption component programmed by Dave Barton.

¢ MD5 hashing component programmed by Greg Carter.

LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm) programmed by South Pacific
Information Services Ltd.

Dream Scripter from Dream Company (http://www.dream-com.com).

AppTools from Anyware (http://www.anyware.co.uk).

APR Dialogs from APR Software (http://aprsoftware.cjb.net).

GraphicEx (image file handling) (http://www.lischke-online.de).

RBCalendar from Borshack Software Solutions (http://www.borshack.com).
ShellBrowser from JAM Software (http://www.jam-software.com).

HyperString from EFD Systems (http://efd.home.mindspring.com).

ThemeManager components by Mike Lischke (http://www.lischke-online.de).

© David Michael. All Rights Reserved.
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1.4

1.5

1.6

e ZipForge components by ComponentAce (http://www.componentace.com).
e RxLib components.

All trademarks are the property of their respective owners.

Dedication

The Journal is dedicated to my wife, Susan, and to our children, Davis and Serene.
Special Thanks

First, | must thank my wife, Susan, for being there, and for being here. | couldn't have finished The
Journal 4 (or any past version) without her.

Next, my hat is off to Sergey Tkachenko, developer of the TRichView components. The Journal 4 owes
a lot to what Sergey has made possible.

The Journal 4 testers: Brett Allen, Rob Barrett, Patricia Campbell, Trudi Champion, Jim Cook, Kathy
Dunham, Laurie Engle, Laura Federico, Gary Filipski, Len Flier, M. Hamilton, Patricia Harris, David
Hollingworth, Peter Hollyer, Floyd Johnson, Lily Labrecque, Patrick S. Lewis, Michael Lowe, Raphael
Love, Jerry McKee, Kevin McKenzie, Gerard Montigny, John Murphy, Noelle Neuwirth, Craig Nicol,
Oskar Ortiz, Tom Plunket, Cindy Rasmussen, Kenneth S. Rhee, Lisa Smith, Brenden Stallard, Steve
Sutton, Andrew Wray, Mel Yow, Stephen Zeoli

Special Thanks from The Journal 3
| would also like to thank Alexis Balmont-Aoutine, Tony Costanzo, Gary L. Filipski, Brian Ford, Pete

Hollyer, Allen Johnson, Floyd Johnson, Sheila Perry, Tom Plunkett, and Julie W. Smith for their help
with testing the initial release of The Journal 3.

Special Thanks from The Journal 1.x and 2.x

Many thanks to Steve Kellock, Marty Brown, Andrew Williams, Sylvia Lutnes, Lance Perry, Ken
Marineau, Matej Trampus, Edmo Abreu Mendes Filho, Bernard Beam, Chris Victor, Gary L. Filipski,
John R. Hutchings, and Alexis Balmont-Aoutine.

Buy The Journal

Click Here to Buy The Journal! (only $39.95)

Benefits of Buying The Journal

o Keep a daily journal! Keeping a daily journal has never been easier! The Journal always knows
what day it is, and automatically brings up a new entry for you every day.

o Get organized! With The Journal's category feature you can be as organized as you want to be!
Keep your "daily pages" separate from your work notes, or your dreams separate from your
correspondence--but only if you want to.

¢ Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any
journaling style you want, or none at all. It's completely up to you!

o The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, and more.

© David Michael. All Rights Reserved.
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¢ Free bug-fixes and feature updates! All 3.x releases of The Journal, whether simple bug-fixes or
major updates, are FREE! *

¢ Free technical support via email! We've tried to make The Journal as easy to use as possible, but
if you have any problems, questions, or suggestions, don't hesitate to email DavidRM Software!

* Some releases of The Journal may include modules that must be purchased separately. However, if
these releases also include bug-fixes or other new features, these will be available free of charge.

For pricing information, including special upgrade rates, see The Journal Pricing.

How to Buy the Journal via the World Wide Web

Click Here to Buy The Journal!

Your payment will generally be processed and your Registration Keys emailed to you within 24 hours.

How to Buy the Journal via "Snail" Mail

Print The Journal Order Form, fill it out, and send it along with your payment to:

DavidRM Software
112 East 54th Street
Tulsa, OK 74105

Please make checks and money orders payable to DavidRM Software.

If you include your email address, you will receive the Registration Keys much quicker. Otherwise, your
Registration Keys must be mailed back to you.

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

1.7  The Journal Pricing

The Journal $39.95
The Journal with MemoryGrabber ™ $49.95
The Journal MemoryGrabber ™ Upgrade $14.95
The Journal with Extended Security $49.95
The Journal Extended Security Upgrade $14.95
The Journal Writing Prompts 1 Package $14.95

The Journal Devotional Prompts 1 Package $14.95

Amounts are in US Dollars.

Click Here to Buy The Journal!

Upgrade Pricing

People who have purchased any previous version of The Journal are eligible for special upgrade
pricing.

© David Michael. All Rights Reserved.
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1.8

The Journal 4 Upgrade $19.95

To receive your The Journal 4 Upgrade Coupon Code, you must submit your full name, mailing
address, and date of purchase to DavidRM Software (davidrm@davidrm.com).

Your Upgrade Coupon Code will be emailed back to you within 24 hours. Enter this code when you
purchase The Journal 4 and you will receive $25 off the regular price (a 50% discount).

Quantity Pricing
Quantity Price Per
1-9 $39.95
10-49 $37.95
50-99 $33.95
100+ $31.95

To purchase The Journal using Quantity Pricing, contact DavidRM Software.

The Journal Order Form
Print this page as an order form.
The Journal Order Form

Full Name

Email Address
Mailing Address

The Journal $39.95 US
The Journal Complete on CD-ROM $89.95 US
Includes:

o Extended Security

e MemoryGrabber

o Writing Prompts 1

¢ Devotional Prompts 1

NOTE: Shipping costs are included in the price.

The Journal with MemoryGrabber ™ $49.95 US
The Journal with Extended Security $49.95 US
The Journal Upgrade from 1.x/2.x/3 $19.95 US
Upgrade Coupon Code:

NOTE: To receive your Upgrade Coupon Code for The Journal 4, email your full name,
mailing address, and date of purchase to: davidrm@davidrm.com

Send payment to:

© David Michael. All Rights Reserved.
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DavidRM Software
112 East 54th Street
Tulsa, OK 74105

Make payable to: David Michael

Please allow 10-15 business days for the payment to arrive and be processed.
All payments are processed the business day they are received.

1.9 Version History

v4.1.0.181
Released 12 June 2006

New Features
o Added support for reminders that happen "every other" day/weekday.

Bugs Fixed
e Pasting HTML into an entry is causing a lockup in some cases.

¢ Deleting reminders sometimes causing errors.

¢ Re-arranging sub-categories sometimes causing errors.

¢ In "View All Reminders", reminders with an effective date sometimes reporting an incorrect

next due date.

When editing an all-day event reminder, the time setting is being shown incorrectly.

¢ Minor display bug of the entry date/name (above the category tabs) when applying User
Preferences.

¢ In some cases, Ctrl+Delete (delete word) behaving oddly.

¢ Changed Redo hot-key to: Ctrl+Y (more standard).

e When using Insert Date, the highlight color of the date format is sticking.

v4.1.0.177
Released 26 April 2006

New Features
¢ Added "View Reminder Notes" to the Reminder menu (and the right-click menu for
reminders).

Bugs Fixed

o Default calendar, entry tree, and category tab font doesn't work well for non-English
language versions of Windows nor under Linux Wine (Windows emulator).

o Exporting multiple entries to TXT, RTF or HTML formats is failing.

¢ When running under Linux Wine, the entry date/name display (above the category tabs)
sometimes gets garbled.

o Clicking "Apply" in User Preferences over and over (for instance, while updating topics)
could lead to extremely slow response time.

The Journal 4.1

March 2006: Though not a major upgrade like the one from v3 to v4, The Journal 4.1 is still a
significant step forward. Reminders & Tasks have now been added to The Journal, supplying whole
new ways you can use The Journal to organize your life and life's work. Set reminders for daily tasks,
monthly appointments, special days and anniversaries, and more! And with the new entry locking
features for shared categories, The Journal edges closer to becoming a true multiuser, maybe even a
collaborative, platform. I look forward to building on all of the 4.1 additions and changes as The Journal
continues to grow.
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v4.1.0.175
Released 17 April 2006

New Features

Added Reminders & Tasks features, including:

o Create new Appointments, Events, Tasks, Special Days.

¢ Options for displaying reminders, see Advanced Reminder Options and

User Preferences: Reminders.

o A new report for seeing completed, skipped, missed, and canceled reminders.

e Reminders can be exported to, or imported from, other scheduling/planning software.
Added "Lock Entries on Edit" and "Prompt for Lock Message" options to
Category Properties, under "Sharing".
Added hot-key Ctrl+Delete to delete the next word.
Added "Insert Topic Name" and "Topic Name Format" options for Topics.
Added the ability to apply overlapping topics.
Added "Hide Highlight" command to Search Results.
Added "Save to File" command to Search Results and Daily/Weekly Entry Report.
Added "New Report" command to Daily/Weekly Entry Report.
Added a hot-key for "Insert Line" (Ctrl+Shift+<dash>)
Added GOFileMenuOverride Journal.INI option.
Added icon (*.ico) image file support to User Images.
Insert Calendar Charm form now remembers last charm selected.
Added "Insert Page Break" to Insert menu.
Countdown timer now defaults to the last duration set.
Added "Edit Category Tab/Entry Tree Font" option to User Preferences.
Updated the backup file format (now compatible with WinZip).
Updated the JNX file format (now compatible with WinZip).
Added a marker file to make it easier to identify a Journal Volume.
You can now kickoff a restore by double-clicking on your .JBK backup file from Windows
Explorer.
You can now kickoff an import by double-clicking on your .JNX export file from Windows
Explorer.

Added "Save HTML with CSS information in .htm(l) file" to Export options in User
Preferences.

Added "Show All Entries" option to the Daily/WWeekly Entry Report.

Reorganized menus:

The "Options" menu is now the "User" menu.

The "Tools" menu is now to the right of the "User" menu.

Global options like "Minimize to System Tray" have been moved to the "Tools" menu.
The "Table" menu is now to the right of the "Format" menu.

The "Go" menu is now to the right of the "Entry" menu.

The "Reminder" menu has been added to the right of the "Topic" menu.

Bugs Fixed

e Sometimes getting an error when trying to load the icon for an external object.

¢ System tray icon sometimes behaving oddly.

e Some menu commands are missing shortcut keys.

o Export Entries doesn't confirm password when exporting to JNX format.

o Drop down list of topics is too short.

¢ Daily/Weekly Entry Report doesn't have a "Deselect All" button for the list of categories.

o Empty tables are showing after a search on topic.

¢ Trying to <include /> a blank entry into an enhanced template hangs The Journal.

o If The Journal isn't "in front" of Windows when the countdown timer reaches 0:00, you can't

see the popup reminder.
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e The Journal is sometimes crashing when closing after editing category properties or
importing entries.

In some cases it's possible to size the calendar to completely obstruct the entry tree.
There is no "link to default entry" option for loose-leaf categories.

Search Entries sometimes not finding text in tables.

Expanded the palette of built-in Calendar Charms.

Cannot use the paste hot-key (Ctrl+V) to paste into the entry name/rename form.
Entries sometimes losing track of the default category background color.

When setting topics, selected text in tables isn't being properly set.

v4.0.0.163
Released 6 December 2005

New Features
o Added "Sort Sub-Entries" when right-clicking loose-leaf entries with sub-entries.
e Added "Go to Entry Bookmark" when right-clicking in entry with bookmarks.

Bugs Fixed
Exporting/importing a category's default entry template not working.

Shared (read only) category entries being set to read only when viewed by another user.
MemoryGrabber Demo is loading for every new user in a Journal Volume.

OEM fonts aren't available for use in text styles.

When printing the selection in the active entry, the <ENTRYNAME/> macro in the page
header is not being replaced with the entry's name.

v4.0.0.161
Released 24 October 2005

New Features

¢ More robust handling of situations where the Journal Volume has been moved or cannot be
found.

e Enhanced template <INCLUDE> tag now supports URL's.
¢ Added new positioning options for entry background images.

Bugs Fixed
Auto-update of packages not always working.

Loose-leaf entries and bookmarks are being duplicated in Insert Link.

Link styles aren't using the style override options for typed links.

Posting to TypePad blogs is getting an error.

Uppercase HTML tags during causing problems in exports.

Some file links not opening their applications when clicked.

Edit Object Description isn't being saved on inserted objects.

The auto-hide isn't working so long as the mouse is hovering over The Journal.
"Get Web Page" sometimes failing to fetch images.

Newly created tables limited to 100 rows.

Headers/footers not printing when printing selection, even if the options are checked.
Doing a backup or repair would lose the current session's entry history.

Pasting rich text format (RTF) sometimes causing performance issues.

Links to entries with a "#" in the name aren't working.

Import Entries doesn't default to showing all supported file types.

v4.0.0.157
Released 26 September 2005
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New Features

Added "Insert Line" to Insert menu.

Added "Insert Bookmark" to Insert menu (same command will remove the active bookmark).
Added "Go to Bookmark in This Entry" to the Go menu.

Added "Check for Update of The Journal" to the Help menu.

Added spell checker option: "Ignore Capitalized Words".

Added spell checker option: "Ilgnore CamelCase words".

Added new Topics option: Default to "Show All Topics" in Editor.

The Journal now becomes read only at the end of the trial period.

Bugs Fixed

Clicking on "Buy The Journal" on nag screen not bringing up the payment page.

"Search Entries by Topic" loading list of categories twice.

No way to create a style with a Type 1 font.

When editing links, email addresses without a "mailto:" aren't accepted.

Pasting links bracketed with < > includes the < > in the link.

Have to manually reload updated add-on packages.

Entry trees that are taller than the visible area, are not automatically scrolling when dragging
entries.

When editing topics, clicking on "Done" doesn't save any pending topic changes.

o Pasting text with a topic active isn't always applying the topic properly.
o Weekly and monthly category entries are repeating in the daily/weekly entry reports.

v4.0.0.153
Released 29 August 2005

New Features

Updated the American English spell checker dictionary and auto-correction dictionary.
Added "Default Entry Template" option for categories.
Added new command line parameter for specifying which Journal Volume to open.

Bugs Fixed

File links in entries not working properly.

Onldle processing sometimes causing too much processor load.

The Journal is triggering a DNS internet access on startup.

Dragging an entry over a master category tab will not bring up that category tab.
Some users seeing "Invalid Image Size" message on startup.

Search Entries AND/OR functionality sometimes reporting incorrect results.

When exporting entries to RTF, TXT , or HTM, sometimes getting an "Index (0) out of
range" error.

Setting an entry background color on the current day's entry in a standard category
sometimes not "sticking".

Using Ctri+Alt+J to hide The Journal when prompted to unlock causes a "stack" of unlock
forms.

v4.0.0.147
Released 20 July 2005

Bugs Fixed

Just hitting ENTER on the Print form isn't printing.

Open Link in New Browser doesn't support Firefox.

"New Search" on the Search Results form behaving oddly sometimes, and not remembering
the "Display only topic text" setting.

Doing "Search Entries" with OR or AND sometimes giving incorrect (>100%) match
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percentages.

v4.0.0.145
Released 13 July 2005

New Features

Added the option to automatically resize (and resample) large images when they are
inserted into entries.

Added the option for Internet links to open a new browser when clicked.

Added "Open Link in New Browser" command to editor context menu.

Added "Search Entries by Topic..." command to Topic menu.

Added option for "Search Entries by Topic" to display only the text assigned to the selected
topics.

Topic name is now displayed when the mouse hovers over text with a topic assigned.

Bugs Fixed

Date/time insert style holdover from TJ3 sometimes causing paragraph spacing problems.
Right-clicking on text just selected by double-clicking selects the entire paragraph (treated
as a triple-click).

o Database corruption issue caused The Journal to fail to open.

v4.0.0.141

In the Search/Search Entries/Search Topics tab, the software wouldn't allow selection of
individual categories.

On Windows 2000, word breaking sometimes acted oddly.

Topics in templates are not being preserved when inserted into other entries.

Image descriptions not becoming ALT text on post to blog.

Auto-correct DUal capitals sometimes incorrectly applied.

URL's with commas in them aren't being properly detected.

When applying a format (bold, italic, etc) to a selection with mixed formats, the new format
removes the other formatting.

No way to hit Ctrl+P and ENTER (to print quickly).

It's sometimes possible to delete the last entry of a standard category.

Post to blog progress meter incorrectly displays progress when uploading images.
Automatic/prompted backup shouldn't wait for the user to click "Start Backup".

Running The Journal from a USB drive sometimes not using the proper Journal Volume
path.

Released 11 April 2005

New Features

New template tag: <ENTRYDATE/> (inserts date of the entry)
Added "Force Text to Black & White" option to Printing Options.
Added "Apply Topic" sub-menu to Topic menu.

Bugs Fixed

System database tables are being accessed unnecessarily between keystrokes.

Spell checker isn't providing enough suggestions in some cases.

Exporting entries with embedded objects for which no server was installed any longer would
see problems. (the very definition of "obscure bug")

Applying bullets/numbering is overriding paragraph before/after spacing.

Duplicate button hot-key on Print form.

Print collating sometimes not collating.

Posting to WordPress 1.5 blog isn't working.

The browse button in backup settings isn't working.
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The timer sound default is hardwired to a particular path/filename.

Relative paths to Journal Volumes causing an error in "Add Journal Volume".
B2Evolution blog support is incomplete (no support for categories).

Categories with the same name sometimes causing problems with entry links.
Unusual system date format can cause problems with entry links.

The auto-resizing of images on print/print preview is sometimes not working (stops the
printing).

v4.0.0.137
Released 2 February 2005
Bugs Fixed
¢ Importing JNX files (.jnx) is reporting an error.
o Deleting a row or column from a table isn't marking the entry as modified.
¢ Installation program requires Windows Administrator privileges.
e Sometimes attempting to load another new user tip on shutdown.
o Some newly inserted images can't be clicked on and selected.
¢ Images in exported HTML files have full file paths instead of just the name of the image file.

v4.0.0.135
Released 24 January 2005

New Features

Most Word Documents (*.DOC) can now be imported with "Import Entries..." and
"Batch Entry Import..."

Added "Do not automatically paste HTML (Paste HTML as Rich Text)" option to
User Preferences: Editor.

Simple templates can now use these enhanced template tags: <DATE/>, <TIME/>
Added support for new blogs: B2Evolution, Blog-City, WordPress

Bugs Fixed

Background color of inserted objects is gray and not the entry background color.

"Starting Page Number" on Print form is being ignored.

Posting to a MovableType/TypePad blog with no categories reports "Post to Blog Error" and
fails.

Bringing up "Entry Statistics" could cause loss of recent changes.

Doing a "Word Count" on an empty entry would report random counts.

A template with an embedded object reports an error on inserting.

Sometimes pasting HTML isn't working (nothing pasted).

Embedded objects are not being exported properly to RTF.

The "Buy The Journal" commands on the menus aren't working.

Fixed some typos and duplicate menu short-cut keys.

Updated/Printed dates on entry statusbar sometimes too big for allocated space.

The "Keep The Journal On Top" menu command doesn't have a toolbar icon.

Clipboard Viewer and other forms getting stuck "behind" The Journal if "Keep The Journal
on Top" is active.

The Journal's automatic hide feature is sometimes interrupting editing of open embedded
objects.

"Insert Link" is resetting the paragraph settings for the active paragraph.

v4.0.0.133
Released 29 December 2004

New Features
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Added a hot-key for block justify: Ctrl+K.
Paste and Paste Special now support pasting HTML from the Windows Clipboard.
Added "Open Object" and "Auto-Size Object" to right-click context menu.

Bugs Fixed

INS/OVR indicator is lagging.

Some TXT files not importing properly with Batch Entry Import.

Deleting a topic could case errors in entries which used that topic.

Combining live spell check with the normal spell check sometimes causes errors.
New object inserted with Insert Object cannot be resized.

Newly inserted object's verb menu not being loaded immediately.

Formatted text sometimes getting confused about the proper font size and text style.
A folder-only category with a once-per-session password is requiring the password every
time a sub-category is brought up.

Auto-Login is sometimes being cleared when opening other Journal Volumes.
Clicking on "Start Backup" more than once causes an error.

v4.0.0.127
Released 8 December 2004

Bugs Fixed

Setting the number of copies to print isn't working.

Errors are popping up when using inserted objects and switching entries or categories.
When bringing up entries with the tree, selection and some inserted objects aren't being
displayed properly.

Changing the properties of an inserted object isn't marking the entry as modified.
There is no default extension/file type on "Save Entry As..."

Search results when using a date range aren't always sorted by date.

On older computers, long entries result in slow typing response.

In some cases, collated printing is not working properly.

Bug in storing certain entry information.

Deleting a sub-category sometimes pops up "Cannot delete..." even if it isn't the last
category.

Using CTRL+TAB to change categories is causing an error.

Links in entries are not always formatted properly when exported/saved to files.

v4.0.0.123
Released 2 December 2004

New Features

Any link of the format "linkType:linkData" can be created with Insert/Edit Link.

Bugs Fixed

¢ Entering Registration Keys sometimes incorrectly reporting "Invalid Registration Keys".

e Search Entries is not using the entered date range.

e Search Entries sometimes reporting an error and stopping abnormally.

¢ Inserting templates (esp from Writing Prompts 1) sometimes causing an error.

¢ In User Preferences, changing "Auto-Save Every" directly is not flagging the "Apply" button.
¢ Loading some pre-4 entries with images is causing an error.

o Edit Links isn't working.

¢ Clicking on an Internet link in search results shows a blank page (though it still brings up the

v4.0

link page in the browser).
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Released 29 November 2004

The Journal 4

August 2004: Though the story of The Journal 4 lacks the drama of The Journal 3's grueling
development period, it's an important upgrade nonetheless. Built on the foundation created in v3, v4
takes The Journal to new levels of power and ease of use.

Work on The Journal 4 began in December 2003, with early efforts centered on switching from using
the Windows Rich Text Common Control to the very powerful TRichView components created by
Sergey Tkachenko. This was a huge change, both in source code and in philosophy, because The
Journal was originally built around the rich text edit, and probably would not have existed except for
that feature of Windows 95. After years spent tweaking and cajoling (and cursing) the rich text edit to
get it to do things that Microsoft probably never meant for it to do, | suffered a few withdrawals.
However, this one change, by itself, made possible a large portion of The Journal 4's new features,
including background images for entries, print preview, tables, and on and on. So I'm past the
withdrawals now, and not looking back.

With the new entry editor in place, | shifted to adding numerous other features that users have asked
for over the years, such as n-depth category nesting, user-created Calendar Charms, and daily/weekly
reporting. Beyond user requests, there were other extensions that | wanted to make, such as the ability
to install and run The Journal on read-only CDROM's, that would make The Journal more stable
overall and useful in new arenas.

By late August 2004, | had implemented the last of the planned additions and on 1 September | handed
The Journal 4 over to a small group of testers. There's nothing like user testing to help smooth out a
new interface and add the necessary polish to new features--and point out the obvious features and
extensions you somehow forgot.

The Journal 4 adds:

¢ A more modern look-and-feel, that tracks Windows XP themes
¢ Improved editing capabilities, including:
Background images for entries
More powerful and more flexible text styles
Improved image handling (faster saving and loading, resizing, and more)
Tables
HTML importing and improved HTML exporting
Paragraph borders and background colors
Outline mode
Improved bullets and numbering
Improved auto-replace, supporting both formatted and unformatted text
¢ Assigning topics to blocks of text within an entry
¢ Improved printing, including print preview
e Improved searching, with:
e Google-like results presentation, with excerpts of found text and links to the found entries
e Search text highlighting in found entries
¢ Date range limiting for standard categories
e Searching by topic, or by image description
Daily/weekly/etc "reporting” for standard categories, with printing
Support for user-created Calendar Charms and entry background images
Improved blog support, with posting of images (if the blog supports posting images)
Web page "archiving" within entries
Improved arranging of loose-leaf entries and categories
Improved category "nesting", so you can have sub-categories of sub-categories of sub-categories
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of...

o New category options likes "Read Only" and "Folder Only"

e The ability to install and run The Journal on self-contained, removable media, like a USB flash drive
or CDROM

e Improved database speed and security

The Journal 3

(November 2001): The Journal 3 is a complete re-design and re-write of The Journal, incorporating
years of accumulated feedback and suggestions. Since The Journal was first released in 1996, users
have sent in their suggestions for features and extensions. As much as possible, these suggestions
were incorporated. But some suggestions were beyond what the original design of The Journal could
tolerate. There was only so far that The Journal's feature set could be stretched without starting over
from scratch.

Begun in the summer of 1999, development on The Journal 3 proceeded slower than expected. Those
initial delays were caused by several factors. | was (and still am) co-owner of another software
company (Samu Games, http://www.samugames.com) and other projects came up that stalled the
development of The Journal 3. Plus there was the ever-present need to support the current version of
The Journal. By the end of 1999, only The Journal 3's new database configuration was completed.

In 2000, two major projects with Samu Games prevented significant work on The Journal 3. The
Journal 2.3 was released in early 2000, and The Journal 2.4 was begun in the fall of the year. Though
the 2.3 release was a relatively straightforward update of The Journal 2.2. The 2.4 release
incorporated some of the features that had been designed for The Journal 3. New word processing
features (like numbered lists and multi-level undo), improved image handling, and especially the new
export/import format were all from work done for The Journal 3.

Most of the work on The Journal 3 that occurred during 2000 was on the new user interface. There
was a lot of experimentation with new layouts, new configurations, and new ways of representing the
categories and entries in the database. Some of it worked, and was kept. A lot of it, though, proved "iffy
at best" and was discarded (or turned into a "user preference”, default off).

In March 2001, following the release of The Journal 2.4, | realized that | had spent too much time on
"research and development". If | expected to release The Journal 3 in this lifetime, | was going to have
to stop thinking up new features to add and experiment with. So the feature set of The Journal 3 was
"frozen", and | began working on getting The Journal 3 done.

Interestingly enough, while The Journal 3 already sported quite a few features that The Journal 2.x
would never be able to duplicate, The Journal 2.x had many more features that had not yet been
implemented in The Journal 3. So to get The Journal 3 "done" | had to get all of the existing 2.x
features working in the new version. Everything from simple options like "minimize to system tray" to
more complex features like entry templates had yet to be added to The Journal 3.

This turned out to be the single largest effort in the development of The Journal 3. The Journal had
accumulated quite a few features in its 5+ years, and re-doing them for The Journal 3 proved to take
more time than | estimated. In August 2001, 6 months later, the last of the 2.x feature set was finally
added to The Journal 3.

In September 2001, The Journal 3 was handed over to a small number of volunteers to see how it
would stand up. With their help, most of the bugs and issues were found and either fixed or resolved.
The last bit of testing and polishing occurred when The Journal 3 "pre-release version" was made
available in mid-November.

The Journal has already grown beyond my original vision for the project. I'm excited to see what new
directions the product will head in the future.
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2004 Afternote: The Journal grew significantly after the initial release of v3. Here's a list of the major
improvements and features added to The Journal from November 2001 to October 2004:

¢ Improved printing

e Improved "Search Entries..."

¢ Improved entry navigation

o Improved entry templates

e Improved initial defaults for new users

o Improved entry export and import

o Improved user interface, including lots of new hot-keys
o Improved entry links and internet links

¢ Improved database maintenance

o Improved documentation

e Calendar Charms

¢ Add-on package support

¢ MemoryGrabber add-on package

o Writing Prompts 1 add-on package

¢ Blog support

v3.0.0.73 -Released 19 January 2005
v3.0.0.71 -Released 22 September 2004
v3.0.0.67 -Released 13 July 2004
v3.0.0.65 -Released 13 April 2004
v3.0.0.63 -Released 6 April 2004
v3.0.0.61 -Released 10 February 2004
v3.0.0.59 -Released 29 December 2003
v3.0.0.57 -Released 15 December 2003
v3.0.0.51 -Released 6 October 2003
v3.0.0.49 -Released 15 July 2003
v3.0.0.47 -Released 9 July 2003
v3.0.0.45 -Released 10 April 2003
v3.0.0.43 -Released 24 February 2003
v3.0.0.41 -Released 9 December 2002
v3.0.0.39 -Released 26 August 2002
v3.0.0.35 -Released 2 April 2002
v3.0.0.33 -Released 18 February 2002
v3.0.0.31 -Released 12 February 2002
v3.0.0.27 -Released 6 February 2002
v3.0.0.25 -Released 4 February 2002
v3.0.0.23 -Released 7 January 2002
v3.0.0.21 -Released 17 December 2001
v3.0.0.19 -Released 3 December 2001
v3.0 -Released 28 November 2001

The Journal 2.x (September 1998 - October 2001)

The Journal 2.0, released in September 1998, built on the feature set that had been finalized in the
1.51 release. More word-processing and security features were added, and database maintenance and
stability were greatly enhanced. Throughout the 2.x series of releases, The Journal continued to
mature, though not at the same pace as before. Refinement and extension replaced a headlong rush
to add new features. The 2.4 release of The Journal, coming nearly a year after the previous release,
was the most significant of the 2.x updates after 2.0.

v2.43 - Released September 28, 2001.
v2.42 - Released August 20, 2001.
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v2.41 - Released April 16, 2001.

v2.40 - Released February 9, 2001.
v2.30 - Released April 7, 2000.

v2.20 - Released December 6, 1999.
v2.11 - Released June 21, 1999.
v2.10 - Released April 5, 1999.

v2.02 - Released February 1, 1999.
v2.01 - Released November 11, 1998.
v2.00 - Released September 30, 1998.

The Journal 1.x (October 1996 - August 1998)

v1.30 was the first shareware release of The Journal, made available in October, 1996. This was a
period of expanding features for The Journal. Hardly a month went by without a new release coming
out with more features--and bug-fixes for previously added features. This "growth spurt" period went on
for nearly a year before finally slowing down.

With the release of The Journal 1.5 in January, 1998, The Journal became a mature software product.

v1.51 - Released February 20, 1998.
v1.50 - Released January 30, 1998.

v1.44 - Released December 12, 1997.
v1.43 - Released September 26, 1997
v1.42 - Released July 19, 1997

v1.41 - Released July 1, 1997

v1.40 - Released June 28, 1997

v1.39 -Released June 7, 1997

v1.38 - Released March 23, 1997

v1.37 - Released February 9, 1997

v1.36 - Released January 12, 1997

v1.35 - Released December 29, 1996

v1.34 - Released December 13, 1996

v1.33 - Released November 25, 1996

v1.32 - Released November 15, 1996

v1.31 - Released October 14, 1996

v1.30 - First Shareware Release October 11, 1996

The Freeware Days (June-September 1996)

The Journal started out as a quick project, mostly as a way to learn how to use Delphi. Fittingly, most
of the original users of The Journal were other Delphi programmers who downloaded it from the
various "Made in Delphi" web pages. Feedback from these and other users prompted me to extend
The Journal significantly, and release it as shareware.

v1.21 - Released August 12, 1996
v1.20 - Released August 9, 1996
v1l.1 - Released July 8, 1996

v1.0 - Initial Release. June 18, 1996
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2.1

How to Use The Journal

Welcome to The Journal!

Thank you for using The Journal! Offering unrivaled ease of use with flexibility and powerful features,
The Journal is the premiere journal/diary software from DavidRM Software.

The Journal for you!

Keep a daily journal! Keeping a daily journal has never been easier! The Journal always knows
what day it is, and automatically brings up a new entry for you every day.

Get organized! With The Journal's categories you can be as organized as you want to be! Keep
your "daily pages" separate from your work notes, or your dreams separate from your
correspondence--but only if you want to!

Do it Your Way! The Journal has no "agenda"--except to be as useful as possible. Use any
journaling technique or style you want, or none at all. It's completely up to you!

The Journal Newsletter! Sent out monthly, The Journal Newsletter provides tips for using The
Journal, articles about journaling and writing, writing exercises, and more.

Features of The Journal

Multiple Users - The Journal supports an unlimited number of users, each with their own password.

User-Defined Entry Categories - Daily entry, weekly entry, monthly entry, even "loose-leaf" are all
possibilities with The Journal! Create as many entry categories as you need. There's no limit! The
Journal even allows users to share categories.

Powerful Editing Features - The Journal includes many powerful word-processing features such as
text formatting (bold, italics, underline, and strikeout), paragraph alignment (left, right, centered,
block), drag-and-drop, live spell check, auto-correction, and powerful printing features.

Stores Anything - The Journal supports more than just text. Insert pictures (most graphic formats
supported) directly in the entry, if you want, or store them in special image entries. You can even
store word processor documents or spreadsheets in The Journal.

Security - The Journal employs password protection and encryption to keep your information safe.
Plus there is a handy "hot-key" for quickly hiding The Journal as well as the option to automatically
hide The Journal if you're idle.

Backup and Restore - Don't trust your valuable entries to the whims of a hard drive or operating
system--backup often!

Customizable - The Journal's menus and toolbars are fully customizable, and with extensive
User Preferences you can make The Journal perfect for you!

Try The Journal FREE for 45 Days!

You can try The Journal (FREE!) for 45 days. During this period, all features of The Journal are
fully functional!
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Contact Information

If you have any questions or comments, DavidRM Software can be contacted at:
Email: davidrm@davidrm.com
World Wide Web: http://www.davidrm.com/thejournal/

See also: Contact Information

2.2 Getting Started

The first time you start The Journal, the New User Wizard is run automatically to help you.

V= Thee Jaisrnal New User Wirard

Welcome to The Journall
Thank you for using The Jourmall
Try The Journal FREE for 45 Days!
You can try The Journal (FREE!) for 45 days.
Durng this period, all features of The Joumal are fuly
functional
Benefits of The Jourmal
+ Keep a daily journall Kesping a daily jpurnal has

v
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The most important parts of this process are:
o Creating your first Journal Volume, and
e Creating your login name.

V= The Jaisrmnal New User Wizrard
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The Journal Volume created during this step will hold your user name, your categories, and all of your
entries. The default location for this Journal Volume is:

C:\Documents and Settings\{WinUserName}\My Documents\The Journal Volumes

See Journal Volumes for more information.

If you are unsure about the Journal Volume, simply accept the default settings. They are adequate in
most cases.
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P The Jawrnal Hew User Wizard
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Your login name and password are how you access The Journal.

If you do not want a password, simply check the "l don't need a password" option. When you are
prompted for your password later, just hit ENTER.

Creating Entries

Creating entries in The Journal is incredibly easy.

Daily Journal

The Daily Journal category that is created for you automatically is a standard (or "daily entry")
category. You'll notice that The Journal has created a single entry for the current date. You can type in
this entry just as you would a word processor or text editor.

To create a past entry, simply click on a past date on the calendar. A new, empty entry will be brought
up for you. The entry is not added to the "tree" of dates below the calendar yet, because the entry is
empty. Once you begin adding text to the entry, then it will show up in the date tree.

leoms ta Thia Jaurnal
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i

As the days and weeks go by, your collection of entries will grow. In the tree of dates, your entries will
be organized by year and month.
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Notebook

At the top of the entry editor, there are a collection of tabs. The active tab should say "Daily Journal".
The one next to it should say "Notebook". Bring up that tab now.

The Notebook category is a loose-leaf category. Unlike the Daily Journal category, the Notebook
category entries are not tied to dates. Instead, the entries are named.
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To create a new entry, click on the Entry menu, choose Create New Entry, and then Document (or
press F9). This will create a new document entry. Enter the name you want the entry to have and hit
ENTER. You now have a new loose-leaf entry following the first one in the tree.

"Notebook Entry" is the default name of entries created in this category. To change the name of the
entry, click on the entry in the tree (or press F2). Then type in what you want to call the entry.

Press F10 ("Create New Sub-Entry") to create a new entry as a sub-entry of the current entry.

A loose-leaf entry can have as many sub-entries as you want. Loose-Leaf entries can also be
organized by dragging and dropping them in the tree.
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Entries can be arranged
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This entry is a sub-en

Click on the second entry in the tree and "drag" it up to the first entry. Then release it. The second
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entry is now a "sub-entry" of the first entry.

This gives you the basics of creating and using entries in The Journal.

For more information, see Entries.
Printing Entries
Once you have created entries in The Journal, a common task is to print those entries.

To print a single entry, bring up that entry. Then click on the Journal menu and choose Print (or press
Ctrl+P). With "Active Entry" selected, click on "Print". That will print the currently selected entry.
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Want to review the entry before you print? Click on "Preview".

You can also print multiple entries, either from the same category or multiple categories. To do that,

bring up the Print form. Click on "These Categories/Entries" and then select the categories and/or
entries that you want to print. Then click "Print".

For more information, see Printing.

To learn more about headers and footers, see Printing Headers and Footers and
User Preferences: Printing.
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2.5 Using Categories

The Journal's categories provide a powerful tool for organizing your journaling or other writing. Each
category provides a separate "folder" of entries.

Creating a New Category

The Daily Journal and Notebook categories are created for you automatically, but you are not limited
to just those. You can have as many or as few categories as you want.

To create a new category, click on the Category menu and choose New Category... That will bring up
the New Category Wizard.
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Enter the name of the category you would like, then choose whether you want a standard category or a
loose-leaf category. If you choose a standard category, you will then have to specify how often you
want the category to create new entries. Choose "Every Day" for now.

Your next choice is type of entry. Choose "Normal Document Entry".

Finally, you are shown all your choices. You can either go "Back" to edit your selections, or "Finish" to
create the category. Click on "Finish".

The new category is added to your collection of category tabs.
Editing Categories

To edit your categories, click on the Category menu and choose Category Properties...

=% Category Properties
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You can edit the name of your category, its order in the tabs, and even whether its tab is visible or not.

See Category Options for more information.

© David Michael. All Rights Reserved.



29

The Journal

2.6

2.7

Database Maintenance

The Journal's entry database has proven very stable over the years, but it is always a good idea to
make regular backups.

The Journal automatically prompts you to make a backup once a week (every 7 days). If you would like
to backup more or less frequently, you can set this using the Backup Options.

See Backup/Restore for more information.
Upgrading from The Journal 3

Upgrading "In Place"” (Most Users)

If you have The Journal 3 installed, then the first time you run The Journal 4 it will detect your existing
Journal Volumes and offer to add them to The Journal 4.

The Journal 4 will need to upgrade your Journal Volume before you can use it. The upgrade process is
usually very quick, and you can optionally create a backup the Journal Volume before it happens.

NOTE: The Journal 4 is not backwards compatible with The Journal 3. Once you start using The

Journal 4, you will not be able to access that Journal Volume from The Journal 3. It is recommended
that you create a backup of all your Journal Volumes before using The Journal 4.

Upgrading from a Backup

If you do not have The Journal 3 installed, but you do have a backup file (*.JBK) from The Journal 3,
you can upgrade from that.

The first time you run The Journal 4, you will be shown the "New User Wizard". On the first page of the
wizard click on "Restore from Backup".

Once the restore has finished, The Journal 4 will ask you to confirm that you want the Journal Volume

upgraded. Follow the on-screen instructions to upgrade the Journal Volume. You will then be able to
log in normally.

Upgrading Add-on Packages

If you have purchased add-on packages for The Journal 3, such as MemoryGrabber and Writing
Prompts 1, you can use them in The Journal 4.

The easiest way to get the packages into The Journal 4 is to run the installation again:

1. Make sure The Journal is not running.

2. Run the installation program for the package. When asked for the folder to install into, change it
from:

C:\Program Files\DavidRM Software\The Journal 3\Package\

To:
C:\Program Files\DavidRM Software\The Journal 4\Package\

Another way is to use Windows Explorer and copy the contents of ...\The Journal 3\Package\ to ..\The
Journal 4\Package\

Upgrade Issues
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Every effort has been taken to ensure that all of your categories, entries, and settings from The Journal
3 carry forward into The Journal 4. But sometimes there are conflicts between old and new.

The following are upgrade/conversion issues that might affect some users of The Journal 3:

o Styles - In The Journal 4, if you change the default style (or user styles) any entries using these
styles will automatically show the new settings. Entries imported from The Journal 3, however, will
not usually reflect the changes without editing.

o Styles with hanging indent - If you have any user styles that have a hanging indent, you may need
to edit the style (Format menu, Styles...) before it will work properly.

o Bulleted text - To indent/unindent bullets in entries imported from The Journal 3, you will have to
toggle the bullets off and then on again.

¢ Entry Header (for Printing) - When printing, the entry header is no longer forced to be double-
spaced above the actual entry text. You will need to edit the entry header (Options menu, User
Preferences..., "Printing" tab, "Edit Entry Header") and add a blank line.

Reverting to The Journal 3
Should you decide not to stick with The Journal 4, you will want to do this:
1. Export all new/edited entries created or changed since you installed The Journal 4.
1.a. Entry menu, Export Entries...
1.b. Click on Options... and make sure that "Use The Journal 3-compatible entry export" is
checked.
1.c. Select the entries you have created/changed in The Journal 4.
1.d. Export these entries to a JNX file.
2. Uninstall The Journal 4.

3. Run The Journal 3 (re-install if necessary). Ignore what you see in the entries (TJ4 entries will look
all black).

4. Restore from the backup created the first time you ran The Journal 4.
4.a. Journal menu, Maintenance submenu, Restore from Backup...
4.b. The backup file is located in the Journal Volume folder, Backup sub-folder.
4.c. Restore the Journal Volume.
5. Import the entries from The Journal 4.
5.a. Entry menu, Import Entries...
5.b. Open the JNX file created in #1.

5.c. Import All
5.d. Auto-Create categories, as necessary

2.8 Upgrading from The Journal 2.x
The Journal can upgrade users, categories, and entries created with any 2.x release.
If you already have The Journal 2.x installed, you can upgrade the entry database easily. Just point the

upgrade process to the folder on your hard drive which contains the 2.x database. The 2.x database
will be copied to a temporary location before the upgrade is processed to prevent any changes to it.
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If you have a backup that was created with The Journal 2.x, you can also upgrade from that. The
backup will be restored to a temporary database, which will then be upgraded.

Upgrading Users

All user-specific settings are upgraded except for some display settings (like the size and position of
The Journal). Settings for "Single User Mode", "Minimize to System Tray", and "Always on Top" are not
upgraded.

Your password is unchanged from the upgrade. It is recommended that you change your password
after upgrading.

If you use "Single User Mode" in The Journal 2.x, it is recommended that you turn if off before you
upgrade so that you can be certain you still remember your password.

Upgrading Categories

All categories are upgraded, whether they are active or inactive.

"Daily" categories in The Journal 2.x are converted to Standard categories (daily).
"Non-Daily" categories are also converted to Standard categories (daily).

"Loose-leaf" categories in The Journal 2.x are converted to Loose-leaf categories. The "tree structure”
of entries is preserved, as is the sorting of entries.

Categories with passwords are upgraded, but the password protection is removed. So any password-
protected categories will have to be given passwords again after the upgrade.

Upgrading Entries

All entries in The Journal 2.x are upgraded.

Frequently Asked Questions

Frequently Asked Questions (FAQ)

Categories

e What is a "category"?

e What is a "loose-leaf" category?

e How do | set a category's default font?
[ ]

[ ]

How do | create a new category?
How do | delete a category?

Entries

How do | insert images in my entries?

Can linsert digital photos in my entries?

How can | use tables in my entries?

How do | make my tables look like those in MS Word/WordPerfect/Etc?
How do | use topics in my entries?

How do | make my entries read only?

How do | post my entries to a blog?

How do | use templates in my entries?
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e How do | have a template automatically inserted in my entries?
e How can | create my own templates?
e Why can't | edit my past entries?

Printing

e How do | set the printer margins?

Database Maintenance
e How do | see what is in my backup file?
e Why is my backup file so large?

Export/import

e How do | synchronize 2 installations of The Journal?
e How can | import my entries from another diary or journal program?

Journal Volumes

e What is a Journal Volume?

e What is The Journal's System Database?
e How do | synchronize 2 Journal Volumes?

Security

e How do | set/change my password?
e What is Extended Security?
e What kind of encryption does The Journal use?

Upgrading

e Will The Journal 4 upgrade my categories and entries from The Journal 2.x/3?

e | am a registered user of The Journal 2.x/3. What is the upgrade price for The Journal 47?

e (The Journal 2.x) Why did my non-daily categories upgrade as standard categories instead of loose-
leaf?

User Interface
e What is the hot-key (keyboard shortcut) for...?
e How do | customize the toolbars?

Glossary

Your question not here? Feel free to ask! Email DavidRM Software.

3.2 FAQ: Categories

What is a "category"?

Cateqgories are a powerful way to organize your entries in The Journal. Example categories are "Daily
Journal", "Notebook", "Work Notes", "Article Drafts", and so on. You can create as many categories as
you want.

There are two types of category: Standard and Loose-leaf.

What is a "loose-leaf" category?

Loose-leaf categories are a collection of entries that are not tied to a particular date (as they are in
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standard categories).

Instead, entries in a loose-leaf category are named documents (or external objects or images). Also,
unlike standard category entries which are always arranged by year, month, and date, loose-leaf
category entries can be arranged in hierarchical "trees" of the user's choosing.

How do | set a category's default font?
To set the default font for a category:

1. Right-click on the category tab, and choose "Category Properties..."
2. Bring up the "Entry Text Style" tab.

3. Click on the "Edit Text and Font Settings" button.

4. Click on the "Font" button.

How do | create a new category?

1. Click on the "Category" menu and choose "New Category..."
2. Choose a name for your category (example: "Dreams").
3. Pick a category type, Standard or Loose-leaf.
e Standard categories are like the "Daily Journal" category, with a new entry every day.
o Loose-leaf categories are like the "Notebook" category, with named entries that you can arrange.
4. Click on "Next".
5. If you are creating a Standard category, you will need to choose how often a new entry is created.
o Daily - a new entry is created every day.
e Weekly - a new entry is created every week, on the specified day (Sunday-Saturday).
e Monthly - a new entry is created every month, on the specified day (1-31).

When you click on "Finish", your new category will be created and you will be able to click on its tab
and start making entries immediately.

Learn more about The Journal's categories here: Categories

How do | delete a category?

1. Right-click on the category tab, and choose "Category Properties..."
2. Select the category to delete from the list of categories.

3. Click on "Delete Category".

NOTE: Deleting a category also deletes all of the entries in that category, as well as any sub-categories
(and their entries). Deleting a category cannot be undone.

FAQ: Entries

How do | insert images in my entries?

Click on the Insert menu, and choose "Insert Image..." Also see: Using Images in Entries

Can | insert digital photos in my entries?

Yes. You can insert just about any kind of image into The Journal, including digital photos (which are
most often compressed JPEG images: *.JPG).

Keep in mind, however, that digital photos larger than 3-4 megapixels (MP) may take a noticeable
amount of time to save and load (1-3 seconds per image, depending on your computer). So you may
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want to crop and/or reduce digital photos of 6+ MP before inserting them. Feel free to experiment and
see what works best for you.

The Journal's Automatic Image Resizing feature can help with inserting digital photos into entries.

How can | use tables in my entries?
See Using Tables.
How do | make my tables look like those in MS Word/WordPerfect/Etc?

You can give your tables the single-black-line border used in most word processors by adjusting the
cell spacing and turning off the table's border.

Select the table.

Click on the Table menu and choose Table Properties...

Click on More... (next to Cell Spacing).

Un-check Equal Values.

Change the Horizontal and Vertical values for Between Cells to: -1
Change the Horizontal and Vertical values for From Table Border to Cells to: 0
Click on OK.

Click on Table Border...

. Under Border Type click on None.

0. Click on OK.

1. Click on OK.

S20oNoooRARLON =

How do | use topics in my entries?

See Using Topics.

How do | make my entries read only?

You can make any entry "read only", to prevent changes to that entry.

1. Bring up the entry you want to make read only.
2. Click on the Entry menu and un-check Edit Entry (hot-key: F4).

You will see "Read Only" displayed on the status bar below the entry.

You can edit the entry again by repeating that procedure. F4 toggles read only status.

NOTE: In standard categories like "Daily Journal", you cannot make the current day's entry read only.
How do | post my entries to a blog?

See Using a Blog.

How do | use templates in my entries?

To insert a template in an entry, click on the Insert menu, and bring up the "Insert Template" sub-
menu. Choose the template to insert, and the text from that template will be inserted in your entry.

How do | have a template automatically inserted in my entries?

1. Right-click on the category tab and choose Category Properties...
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2. Bring up the Entry tab.
3. Select the Default Entry Template from the available drop down list of templates.

The selected template will be inserted into new entries. For standard categories, this template will be

inserted into new entries for the current day. For loose-leaf categories, the template will be inserted
into all newly created entries.

How can | create my own templates?

See Creating Simple Templates and Creating Enhanced Templates.

Why can't | edit my past entries?

In your category, past entries may be set to be "read only". You can override this by clicking on the
Entry menu and choosing "Edit Entry" (or pressing the hot-key: F4).

You can change the setting to default to make past entries edit-able:
1. Click on the Category menu and choose "Category Properties..."

2. Bring up the "Standard" tab.
3. Un-check the "Past Entries Read-Only" option.

FAQ: Printing

How do | set the printer margins?

To set the printing margins:

1. On the Options menu, click on "User Preferences..."

2. Bring up the "Printing" tab.

3. Click on "Edit Default Page Setup".

4. Then you can set the margins to how you want them, and click "OK" when you're done.

Those settings will be used everywhere, unless you override them at the category level.

FAQ: Database Maintenance

How do | see what is in my backup file?

On the Journal menu, find the Maintenance sub-menu, and choose "Restore from Backup". Your last
backup archive will be automatically opened.

Each Journal Volume will be listed, and if there are multiple backups per Journal Volume, the date of
each backup will be also be listed.

If you want to see what's in a particular backup, it's recommended that you create a new, temporary
Journal Volume. And then do the restore into the new Journal Volume.

Why is my backup file so large?
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The Journal's backup files can function as "backup archives", storing multiple backups in a single file.
The default setting is 1 backup per Journal Volume, though you can set this to any number you wish. It
is not recommended that you set this number higher than 5.

Backups to removable media, such as floppy disks and Zip disks, cannot use this feature.

See Backup Options for more information.

3.6 FAQ: Export/import

How do | synchronize 2 installations of The Journal?

It is possible to keep entries across multiple Journal Volumes "in sync" using the export and import
features of The Journal.

See the Export/Import Overview and Synchronizing Journal Volumes for more information.

How can | import my entries from another diary or journal program?

The Journal supports batch entry import, which makes it relatively simple to import entries from other
diary or journal programs.

See Importing Entries from Other Journal Software and Batch Entry Import for more information.

3.7 FAQ: Journal Volumes

What is a Journal Volume?

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Journal Volumes can be placed on any available hard drive, or even removable media like lomega's
Zip disks. Each Journal Volume must have a unique name.

Most users of The Journal will only need a single Journal Volume.

See Journal Volumes for more information.

What is The Journal's System Database?

The Journal's System Database stores the names and locations of all Journal Volumes, as well as
certain global settings. The System Database is always stored in the "System" folder under the folder
where The Journal is installed.

See The System Database for more information.

How do | synchronize 2 Journal Volumes?

It is possible to keep entries across multiple Journal Volumes "in sync" using the export and import
features of The Journal.
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See the Export/Import Overview and Synchronizing Journal Volumes for more information.

3.8 FAQ: Security

How do | set/change my password?
Click on the Options menu and select "Change User Password".

You will need to enter your current password (unless you have a blank password) to create a new
password.

What is Extended Security?

Extended Security enhances The Journal's normal security by adding an additional layer of protection,
and a couple of security-related options.

The Journal's "basic" security is quite good, more than most people will ever need. Extended Security
builds on that to make The Journal as secure as possible.

See Extended Security for more information.

What kind of encryption does The Journal use?
Encryption of entries uses the Twofish block cipher designed by Bruce Schneier.

See Security Details for more information.
3.9 FAQ: User Interface

What is the hot-key (keyboard shortcut) for...?

All hot-keys are listed here: Keyboard Shortcuts

How do | customize the toolbars?

Right-click on the menu or toolbar that you want to customize, and choose Customize. This will open
up a form which contains all available menu and toolbar commands.

Drag the commands you want and drop them on the menu or toolbar where you want them.

3.10 FAQ: Upgrading

Will The Journal 4 upgrade my categories and entries from The Journal 2.x/3?

Yes, The Journal 4 will upgrade your existing categories and entries from any past version of The
Journal.

See Upgrading from The Journal 3 or Upgrading from The Journal 2.x for more information.
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| am a registered user of The Journal 2.x/3. What is the upgrade price for The
Journal 4?

If you purchased The Journal from July 1, 2004, up to the release of The Journal 4, you are eligible for
a free upgrade. Email DavidRM Software to request your Registration Keys for The Journal 4. Include
your full name, mailing address, and date of purchase.

People who have purchased any previous version of The Journal are eligible for special upgrade
pricing.

See The Journal Pricing for more information.

(The Journal 2.x) Why did my non-daily categories upgrade as standard
categories instead of loose-leaf?

Before there were loose-leaf categories, non-daily categories fulfilled a similar need. Non-daily
categories were essentially just daily categories that were "frozen" on a particular date. Though their
entries were displayed in a manner similar to loose-leaf entries, each entry was tied to a particular
date.

Non-daily categories were discontinued as a feature in The Journal 3. However, it was still necessary
to convert them. Because of how the entries were created and tracked, the only option was to upgrade
them into a standard category.

You can use the F7 (Previous Entry) hot-key to review the entries in the converted category. If you

want to convert the category to loose-leaf, you will need to create the new category. Then you will need
to use copy-and-paste to move the entries.

4 The Journal Reference

4.1 Glossary

Auto-Login

Called "Single User Mode" in previous versions of The Journal, auto-login automatically logs you in
when you start The Journal.

Blog

Short for "Web log", a form of public diary usually posted on a Web site. See Using a Blog for more
information.

Calendar Charms

Calendar Charms are icons, or small graphic images, that can be assigned to entries. The entry's
Calendar Charm is then displayed on the calendar and in the category's entry tree. Calendar Charms
can also be inserted into entries.

Categories
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Categories are a powerful way to organize your entries in The Journal. Example categories are "Daily
Journal", "Notebook", "Work Notes", "Article Drafts", and so on. You can create as many categories as
you want.

There are two types of category: Standard and Loose-leaf.

Categories, Standard

Standard categories are also called "daily entry" categories. However, standard categories can be
either daily entry, weekly entry, or even monthly entry. Standard category entries are tied to a specific
date (or range of dates), and only one entry can exist in the category for that date.

Categories, Loose-leaf

Loose-leaf categories are often called "notebook" categories. Entries in a loose-leaf category are not
tied to any date. Instead, they are named documents (or external objects or images). Also, unlike
standard category entries which are always arranged by year, month, and date, loose-leaf category
entries can be arranged in "trees" of the user's choosing.

Categories, Shared

A shared category is a category that can be accessed by each user that links to it (and provides the
optional sharing password). All entries in the shared category are available.

Date Tree

The "date tree" is the list of entries below the calendar. Entries in the date tree are organized by year
and month.

Entries

Entries, organized by category, are the core of The Journal. Entries can be text "documents”,
external objects, or images. Most standard categories use document entries, though any type can be
set as the default for the category.

Entries, Document

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any TrueType font installed on your PC can be used to format the text.

Entries, External Object

External object entries are essentially Windows data files stored in (or linked from) The Journal.
Double-clicking an external object entry will open the entry using the associated Windows application.
If possible, the application will be "hosted" inside The Journal.

Entries, Image
Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.
Exporting

Using The Journal's export features to make entries available to other software or to synchronize
Journal Volumes.
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Importing

Bringing files created by other applications (including other journal software) into The Journal. See
Importing.

Journal Volume

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

Links

The Journal supports hypertext-style links in document entries.

There are two types of link: entry links and Internet links. Entry links are links to another entry in The
Journal. Internet links are links to web pages or email addresses.

Links, Entry

Entry links are special "hyperlinks" in The Journal to allow one-click "jumping" to another entry.
Links, Internet

Internet links are web page addresses, email addresses, and so on.

Style

A style is a pre-defined text format. A style can set the font, change paragraph settings, use numbers
or bullets, and more.

System Database

The Journal's System Database stores the names and locations of all Journal Volumes, as well as
certain global settings.

Topic

A topic is another way to organize your entries. You can set a topic (e.g., "Feelings: Anger") to the text
of entry, either as you type it or afterward. You can set as many topics within an entry as you wish. You
can then search entries with a topic or topics and review them.

4.2 Blog Support
421 Blog Support

The Journal's "blog" (Web log) support gives you the ability to post entire entries (or just selected
portions), both text and images, to public blogs--without sacrificing privacy and security. You choose
what entries and information are posted to your blog, and keep sensitive and/or private information
inside The Journal.

Blogs Supported
e B2Evolution (www.b2evolution.net)

¢ Blog-City (www.blog-city.com)
¢ Blogger (www.blogger.com)

© David Michael. All Rights Reserved.


http://www.b2evolution.net/
http://www.blog-city.com
http://www.blogger.com

41 The Journal

o CafelLog (www.cafelog.com)

o LiveJournal (www.livejournal.com)
¢ MovableType (www.movabletype.org)
o TypePad (www.typepad.com)

o WordPress (www.wordpress.org)
[ ]

[ ]

[ ]

[ ]

Custom: Blogger (blogs that support the Blogger API)

Custom: LiveJournal (blogs that use the LiveJournal APl/source code)
Custom: MetaWeblog (blogs that support the MetaWeblog API)
Custom: MovableType (blogs that support the MovableType API)

Support for more blogs will be added as users request them. So if you don't see your favorite, check
Setting Up a Custom Blog or contact DavidRM Software (davidrm@davidrm.com).

Using a Blog
Blog Profile

4.2.2 Using a Blog

Here are the steps to using a blog with The Journal:

1. Create your Blog Account

First, you will need a blog account to post to. Many blog hosts, like LiveJournal and Blogger, provide
free accounts. You just have to sign up for one.

2. Create a Blog Profile in The Journal
Next, you need to create a blog profile so The Journal knows how to post to your blog.
Click on the Tools menu, bring up the Post to Blog sub-menu, and choose Blog Profiles...

On the Blog Profiles form, click on Create New Blog Profile and enter the necessary information:
¢ Blog Tool (example: LiveJournal)

¢ Alias/User Name (example: DavidRM)

e And so on.

In most cases, you can leave the rest of the blog profile settings as they are.

3. Make an Entry in The Journal

Bring up a blank entry and type up the text you want to post to your blog, just like you were making a
normal entry in The Journal.

4. Post the Entry to your Blog

Select the text you want to post to your blog and right-click on it to bring up the editor's context menu.
Open the Post to Blog sub-menu and select the blog profile to use.

You will be prompted for your password, and then the selected text will be posted to your blog.

That's all there is to it!
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4.2.3 Blog Profile

Blog Tool

Identifies the type of blog (e.g.: LiveJournal). Each blog tool has its own way of posting new entries.
Once set, the blog tool for a profile cannot be changed.

Alias

This is your alias/user name on the blog tool. Required when logging into the blog to post an entry.

Blog API - Host

This is the host site of your blog (e.g.: www.livejournal.com). The Journal communicates with this site
to post the entry to your blog.

Blog API - Page

This is the page (e.g.: /interface/xmirpc/) on the blog's host site which The Journal uses to post the
entry to your blog.

Blog API - Port

The port number (e.g.: 80) used to communicate with the host site. This number will be 80 in most
cases.

Blog API - Timeout

The timeout value specifies how many seconds to wait for the host site to respond before cancelling.

Proxy Settings
Do not use a Proxy Server - Use a direct connection (no proxy server) to the blog's host site.

Use Internet Explorer Proxy Settings - Use Internet Explorer's proxy settings to connect to the blog's
host site.

Use These Proxy Settings - Specify your proxy server information yourself. You must enter both an
Address and a Port. If necessary, you can also enter your proxy User Name and Password.

Export Settings
No Formatting (Simple Text) - Post entries to the blog as simple text, with no formatting.

Force doublespace between paragraphs - Force doublespacing (a blank line) between paragraphs.
NOTE: This option is only available if No Formatting is selected.

HTML Formatting - Post entry to the blog, preserving text formatting with HTML. NOTE: Not all text
formatting supported in The Journal is available in HTML.

Preserve paragraph/tab indents - Convert tabs used indent paragraphs to blank space to preserve
the indentation. NOTE: This option is only available if HTML Formatting is selected.

© David Michael. All Rights Reserved.



43

The Journal

424

4.3
4.3.1

Additional Settings

Make Blog Posts Private - Post the entry to the blog as private, or not visible to other bloggers. Not
supported by all blog types.

Prompt for a Title when Posting - Prompt for a subject/title for the blog post. Not supported by all
blog types.

Save Password for this Profile - Save the password for this blog profile so that you don't have to type
it in every time. Un-check this option to clear the saved password and be prompted again.

Always Post to this Blog - If you can post to multiple blogs with this blog profile, you have the option
of always posting to the same blog, to avoid being prompted over and over. Un-check this option to be
prompted again.

Setting Up a Custom Blog

Even if the blog site you use isn't listed in the Blog Profiles form, there's is still a good chance that The
Journal will work for you.

Gather the Necessary Blog Information

Check in your blog site's Help or FAQ (Frequently Asked Questions) section to find these bits of
information:

1. API supported - Many blog sites support the Blogger API. The MetaWeblog is also popular. You
need this information so you can choose the correct "Blog Tool" in your blog profile. If you cannot find
this information, try "Custom: Blogger API".

2. Host site - The Journal communicates with the host site to post the entry to your blog. For many
blog sites, this is the same as blog's home page (e.g., www.typepad.com).

3. Page - This is the page that is posted to on the host site.
The Host site and Page may be displayed as combined. Example: www.typepad.com/t/api/
In this case, you would separate the Host and Page like this:

Host: www.typepad.com
Page: /t/api/

NOTE: The Page may require a trailing slash (/).

Create Your Blog Profile

Once you have the above information, you can create your blog profile as described in Using a Blog.
Categories

Categories

The Journal's categories provide a powerful tool for organizing your journaling or other writing.

You can have as many categories as you want.

The Journal supports two kinds of category: standard and loose-leaf.
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Standard Categories

Standard categories are also called "daily entry" categories. Standard categories can be either daily
entry, weekly entry, or even monthly entry. Entries in a standard category are tied to a specific date (or
range of dates), and only one entry can exist in the category for that date.

Loose-leaf Categories

Loose-leaf categories are often called "notebook" categories. Entries in a loose-leaf category are not
tied to any date. Instead, they are named documents (or external objects or images). Also, unlike
standard category entries which are always arranged by year, month, and date, loose-leaf category
entries can be arranged in hierarchical "trees" of the user's choosing.

"Folder Only" Categories

Any category can be designated as a "folder only" category. These categories are used to help you
organize your categories and sub-categories.

4.3.2 Standard Categories

Standard categories are often called "daily entry" categories. This is for historical reasons as well as
because most often they are daily entry categories.

Entries in a standard category are always tied to a particular date or range of dates. Also, only one
entry can exist per date or range of dates.

The calendar is very important to standard categories. Standard categories automatically create an
entry when a particular date is selected.

Standard categories can create entries for a date, for a week, or for a month. The default setting is an
entry for every day. New weekly entries are created according to the day of the week (Sunday,
Monday, etc.). New monthly entries are created according to the day of the month (1, 2, 3, etc.).

See Standard Category Options for more information.

4.3.3 Standard Category Options

These options are only available to standard categories.
Create New Entry in Category
Every Day

Each day, after the time specified in User Preferences: General, a new entry is created.

Every Week on this Weekday

Each week, on the specified day, after the time specified in User Preferences: General, a new entry is
created.

Every Month on this Date

Each month, on the specified date (1-31), after the time specified in User Preferences: General, a new
entry is created.

NOTE: If the specified date is greater than the number of days in the month, then the entry for that
month will be created on the first of the following month.
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Past Entries Read-Only
If checked, then past entries of the category are read-only by default. This setting can be overridden to
make changes to the entry ("Edit Entry" on the "Entry" menu, or press F4).
Even if this option is checked, you can make certain past entries read-only by overriding this at the
entry level. Bring up the entry, and choose "Edit Entry" on the "Entry" menu (or press F4).

4.3.4 Loose-leaf Categories
Loose-leaf categories are often called "notebook" categories because of the default "Notebook" loose-
leaf category that is created for new users of The Journal.
Entries in a loose-leaf category are not tied to a specific date. Instead, they are like named documents
(or files in the case of external objects). The entries can be of any kind: document, external object, or
image.
A powerful feature of loose-leaf categories is that their entries can be arranged in an hierarchy or
"tree". Thus, entries can have sub-entries, and those sub-entries can sub-entries, and so on. Arrange
your entries by clicking on the entry to move and "dragging"” it where you want it.

4.3.5 Shared Categories
Categories can be "shared" between users within a Journal Volume.
A shared category can be accessed by each user that links to it (and provides the optional sharing
password). All entries in the shared category are available.
Categories can be shared as either "read only" or "full access". A read only shared category allows all
entries in the category to be read, but those entries can only be updated by the user that owns the
category. The entries in a full access shared category, on the other hand, are treated just like any other
entries. They can be read, edited, deleted, or even re-arranged (in loose-leaf categories).
See Category Options: Sharing for more information.

4.3.6 Packages
Packages are collections of categories that can be installed into The Journal.
E-books, articles, templates, and more can be added to The Journal with packages. Once a package
is installed, the categories in the package are available as shared categories.
Some packages may create new categories for you automatically. For example, the MemoryGrabber
package for The Journal creates a "My MemoryGrabber" category for you to fill out. The questions and
prompts for the different parts of your life are typed in, so all you have to do is type in the answers to
quickly and easily create your memoirs.

4.3.7 Category Options
Categories in The Journal are highly configurable.
General
Entry
Entry Text Style
Security
Sharing

Also see Standard Category Options for more information.
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4.3.8 Category Options: General

These options are available to all category types.

Category Name

This is the name of the category. The name of the category can be changed at any time.

Category Active (Tab Visible)

If this option is un-checked, no tab shows up for the category because it is considered "inactive". Use

this option to "hide" categories that are no longer as active as they were. Should you need to access
the entries in the category, it's a quick and simple matter to make the tab visible again.

Show Calendar when Category is Active

If checked, this option makes The Journal's calendar visible whenever this category is selected.
Show Tree when Category is Active

This option displays the entry "tree" whenever the category is selected.

Category is Folder Only

This option is only available for categories that have sub-categories. By default, a Master Category
presents itself as a sub-category of itself. By setting the category as "Folder Only", though, this doesn't
happen.

Sort Order

The sort order option controls in what order the category tabs are displayed.

Master Category

The Journal supports one level of "nested" categories. The Master Category is the category the current
category is "under".

Only the Master Category tab is visible. Sub-category tabs are only visible when the Master Category is
active.

4.3.9 Category Options: Entry
These options are available to all category types.
Default Entry Template
The selected template will be inserted into new entries. For standard categories, this template will be

inserted into new entries for the current day. For loose-leaf categories, the template will be inserted
into all newly created entries.

Entry Type

This setting determines the default entry type of the category, and what kind of entry newly created
entries will be.
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In loose-leaf categories, this setting can be overridden to create an entry of any type.
Normal Document Entry

Document entries are formatted text documents, much like word processor files. It is recommended
that standard categories use document entries.

See Document Entries for more information.

External Object Entry
External object entries are essentially Windows data files stored in (or linked from) The Journal.

See External Object Entries for more information.

Image Entry
Image entries are graphic files (BMP, JPG, etc).

See Image Entries for more information.

Document Entry Options
These settings control document entries within the category.
Edit Page Setup, Header, Footer

Use these settings to override the page setup, header, and footer created in
User Preferences: Printing.

Default Page Setup, Page Header, Page Footer, and Entry Header

Use this setting to restore the page setup, page header, page footer, and entry header created in
User Preferences: Printing.

Category Options: Entry Text Style

These options are available to all category types.

Entry Background Color

This is the default color used for the background of document entries.

NOTE: If this setting is changed, entries created with the previous color setting will not be changed.
This is because background color and font are often coordinated, and overriding the setting of the

existing entries might make them unreadable. The background color of existing entries can be
changed by hand, however.

Entry Background Image
This is the default background image used for entries in this category.

Edit Font and Text Settings

Every category can specify its own "default style". If no default style is given, then the default style
setting from User Preferences: Styles is used.
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See Styles for more information.
Default Settings

This button restores the background color and default style to those set in User Preferences: Styles.

4.3.11 Category Options: Security
These options are available to all category types.
Category Entries are Read Only (and no new entries)

When checked, this category and its entries cannot be edited or deleted. Also, no new entries can be
created.

Category Password

If you want this category to have a password, enter it here. You will also need to enter the category in
the "Confirm Password" field.

If the category already has a password, you will need to enter the existing password to change it or to
clear it.

Only Verify Password Once per Session
If checked, you will only need to enter the category's password once per journaling session.

If this option is not checked, you will have to enter the password every time the category is selected.

4.3.12 Category Options: Sharing

These options are available to all category types.
Lock Entries on Edit

If you are using The Journal over a network and/or sharing categories between users, and there is a
possibility that multiple users will be accessing and updating the entries of this category at the same
time, you might want to have this option checked. When a user edits an entry, that entry will be locked,
preventing other users from editing the entry at the same time.

Prompt for Lock Message
When "Prompt for Lock Message" is checked, all entries in the category are "Read Only" by default,
and you must use Entry | Edit Entry (hot-key: F4) and enter a lock message. This lock message is

displayed to any other users who attempt to edit the entry. Use this option along with "Lock Entries on
Edit" to further coordinate your editing with other users.

Category is Shared

If checked, this option allows other users within the Journal Volume to link to this category and access
its entries.

Read Only?

This option is only available if the category is shared. If checked, then other users can only read the
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entries in the category. They cannot edit, delete, or re-arranged the entries in any way.

Category Share Password

If you want this category to have a share password, enter it here. You will also need to enter the
category in the "Confirm Password" field.

The share password is different from the category password described in Category Options: Security.
The share password must be entered correctly by other users to access the category.

If the category already has a share password, you will need to enter the existing password to change it
or to clear it.

See Shared Categories for more information.

Delete Category

It is possible to delete a category and all of its entries.
NOTE: Neither the category nor its entries can be recovered once deleted.

Database Maintenance

Backup/Restore

The various Journal Volumes and The Journal's System Database should be backed up regularly.

To backup The Journal, you have to login normally.

Backups can be made to any valid drive or folder on your PC. If the backup destination is a removable
media, such as a floppy disk, the backup process will automatically prompt you for additional disks
when the backup gets too large.

It is possible to restore a backup made with a previous version of The Journal. However, a special
Journal Volume must be created for the restore.

Backup Options

The only way to set the backup options is to bring up the Backup form. On the Journal menu, find the
Maintenance sub-menu and choose Backup The Journal.

Backup Archive Name
This is the name used for actual backup file.

If the backup is broken into segments, for instance from backing up to a floppy disk, then the segment
number is added to this name.

Backup Destination Path
This is the folder or drive path where the backup will be located.

If the backup destination is a removable media, like a floppy disk, then the backup file will be
automatically segmented to fit.

Backup Journal Volumes
e Current Journal Volume
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¢ All Journal Volumes (default)
e Selected Journal Volumes

This option specifies which Journal Volumes are to be automatically backed up.

Backups per Volume

The Journal's backup files support maintaining multiple backups for a particular Journal Volume within
a single backup. Each backup is dated according to when the backup was made.

Once the number of backups for a Journal Volume reaches this number, then the oldest backup is
deleted to make room for the new one.

Backups to removable media, such as floppy disks and Zip disks, cannot use this feature.
Include The Journal System Database in Archive

The Journal's System Database is only backed up if this option is selected.

Prompt for Backup Every nn Days

The Journal will prompt for a backup on closing if this option is set.

4.4.3 Restore

Backup Archive
This is the name of the backup archive (*.JBK).

You can restore from a backup made by a previous version of The Journal (*.JBU or *.001). In this
case, a Journal Volume must be created especially for the restore and upgrade.

Volumes in Archive

Once a backup archive has been selected, this will list all of the Journal Volumes that have been
backed up into this archive. If a Journal Volume has backups from different dates, these will be listed.

Restore Volume

This command will restore the selected Journal Volume. Unless you pick an earlier date, the restore
will automatically use the most recent backup of the Journal Volume.

Create Volume

This command allows you to create a new Journal Volume. If you do not want to restore into an
existing Journal Volume, you will need to create a new Journal Volume before starting the restore
process.

4.4.4 Repair The Journal Databases

To repair The Journal's various Journal Volumes and/or the System Database, bring up the Journal
menu, then the Maintenance sub-menu, and choose Repair The Journal Databases.

The repair process re-builds The Journal's database files, correcting any problems that may have
appeared due to system shutdown issues or Windows crashes. The repair process also minimizes the
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amount of space required for all database tables.

In general, The Journal's database tables are quite stable. It is unlikely you will need to use the repair
process more than once or twice per year.

See Journal.INI for how to force The Journal to repair all databases on startup.
Repair Journal Volume
This button repairs only the currently active Journal Volume.

Repair All Journal Volumes

This button repairs all Journal Volumes.

Repair System Database

This button repairs The Journal's System Database.

4.4.5 Delete Users

To remove a user from the current Journal Volume, you must be able to provide the user's password.
The user and all of her categories and all of her entries in those categories will be deleted.

Deleting a User
1. Click on the Journal menu, find the Maintenance sub-menu, and choose Delete User(s)...
2. Choose the user login name to delete.
3. Enter the user's password.
4. Click on Delete. You will be asked to confirm the delete one more time before it actually happens.
NOTE: Once deleted, a user CAN NOT be recovered.
4.5 Entries

451 Entries

Entries, organized by category, are the core of The Journal. Entries can be text "documents"”, external
objects, or images.

Most standard categories use document entries, though any type can be set as the default for the
category.

A category can have either document entries or external object entries as its default entry type. This
setting can be changed at any time.

NOTE: Only document entries and images can be printed by The Journal. External objects cannot be
printed. You will need to use the native application of the external object to print it.

Document Entries
External Object Entries

Image Entries
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4.5.5

Document Entries

Document entries are formatted text documents, much like word processor files. Text can be entered
freely to any length. Any TrueType font installed on your PC can be used to format the text.

Images and external objects, such as spreadsheets or data files, can be embedded in a document
entry using Windows OLE/ActiveX features.

External Object Entries

External object entries are essentially Windows data files stored in (or linked from) The Journal. If
possible, The Journal will use the standard icon for the file when displaying the entry in the date or
entry tree.

Double-clicking an external object entry will open the entry using the associated Windows application.
If possible, the application will be "hosted" inside The Journal.

External object entries can be "linked" to a file. When linked, the file is not stored inside The Journal.

External objects cannot be printed by The Journal. Instead, you will need to use the default application
for that external object to print it.

Image Entries

Image entries are graphic files (BMP, JPG, etc) that are stored in The Journal.

Images can be bigger than the visible region of the screen. Clicking and dragging will scroll the image.
The image can also be scaled using the "wheel" on your mouse.

Image entries are much more space efficient than embedding images in document entries because
they store the image in its native format.

When printing image entries, the image is scaled to fit the page.

Search Entries

Beyond searching for a word or phrase in a single entry, The Journal supports queries that can span all
categories and entries. Plus you can search for text (word, phrase, collection of words), and you can
search for topics.

NOTE: Searching is currently limited to document entries.

Once the search is begun, it continues until all entries in the selected categories have been searched.
The search can be stopped at any time, or it can be allowed to continue while you browse the entries it
has found so far.

Search Text

Enter the word, words, or phrase you want to search for here. Words in quotes "like this" are treated as
a single word.

Queries are not case-sensitive, so don't worry about uppercase and lowercase.

Text Search Options

o Search for entire phrase - The search text is taken as a single phrase. The entire phrase must be
matched for the search to find anything.

e Search for entries with any of the words (OR) - The search text is a collection of words (or quoted
phrases). If an entry contains any of these words, it will be listed. A "Match %" will be displayed,

© David Michael. All Rights Reserved.



53

The Journal

4.5.6

indicating what percentage of the searched for words are present in the entry.

e Search for entries with all of the words (AND) - The search text is a collection of words (or quoted
phrases). An entry must contain all of the words to be listed as a match. The words don't have to be
in any particular order in the entry to match, however.

Where to Search

e Search entry text - Look for the word(s) in the text of the entry (a normal search).

¢ Search entry names - Look for the word(s) in the names of entries.

e Search image/object descriptions - Look for the word(s) in the descriptions of images and objects.

By default, the search will look in all of these (text, entry names, and image descriptions). Turn off one
or more of these to narrow the scope of the search (for example: to search only in image descriptions).

Search Topics
Select the topic(s) you want to search for.

The topics you have used at least once in an entry are listed first, in alphabetical order. All other topics
are listed in alphabetical order following the ones you have used.

Topic Search Options
¢ Display only topic text in Search Results - In the Search Results, when viewing an entry (or all
entries), only those parts of the entry tagged with the selected topic(s) will be displayed.

Search Categories
You can limit the number of categories searched. By default, the search looks in all categories.

Search this date range only (for standard categories)
Check this option to limit the search to standard categories (like "Daily Journal"), and to further limit the
search to the specified date range.

Search active category only
Check this option to look only in the active category.

Search Results

This form is brought up when a search is begun.

Once the search is begun, it continues until all entries in the selected categories have been searched.
The search can be stopped at any time (click "Stop Search"), or it can be allowed to continue while you
browse the entries it has found so far.

Unless you specifically "Close" the Search Results form, or "Stop Search", the search will continue.

Found entries are displayed in a manner much like that used by search engines on the Web:

Daily Journal - Wednesday. September 08. 2004

... some search text here ...
Entry link: journal:Daily Journal[9/8/2004]

The first line is an entry link. Clicking on the entry brings up that entry, with search text (or search
topics) highlighted.

The next line shows one example of the search text found, with some context both before and after.
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The last line is a static entry link, showing the category and entry date or name.

If the Search Results form is ever hidden from view, you can bring it back by choosing Search Entries
on the Search menu, or by pressing the hot-key: Shift+Ctrl+F

Stop Search

Stops the current search (if it hasn't already completed).

New Search

Stops the current search and brings up the Search Entries form again.

Results per Page

You can set the number of results shown per page, from 1 to 100.

Print/Print Perview

Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.
Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.

Hide Highlight

This command toggles the highlighting of search terms. This can be useful when printing the search
results, or saving them to a file.

Save to File
Click on this command to save the search results to a file on your computer.

Daily/Weekly Entry Report

Use the Daily/Weekly Entry Report to collect all of the entries made in a given date range: a day, a
week, a month, a year, or any range at all.

NOTE: This report is for standard categories (like Daily Journal) only.

Example:

You have a project-specific standard catogry called "Project Notes" where you track your daily
progress, meeting notes, and so on. On Monday, you want to print out a report of what you did the
previous week. So you:

1. Bring up the "Project Notes" category tab.

2. Click on the Tools menu, choosing Daily/Weekly Entry Report...

3. Select Last Week.

4. Click on See Report.
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All of last week's entries in "Project Notes" are now compiled in proper order. You can review them and
then print them.

Show all Entries from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This
Month, and Last Month. You can also choose to Show All Entries.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:

You can have the report created from the Active Category or All Standard Categories. Or you can
choose These Categories and select the specific categories to look in.

Daily/Weekly Entry Report Results

When the Daily/Weekly Entry Report collects all of the appropriate entries, it uses this form to display
the results.

The entries are sorted by category, and then by entry date. The category name is displayed before the
first entry from that category, and the entry name is displayed before each entry.

New Report

Discards the current report and brings up the Daily/Weekly Entry Report form again, so you can create
another report.

Print/Print Perview
Print (or Print Preview) will print either the list of results currently displayed, or the entry selected.
Page Break

To provide more control over the printing, you can insert page breaks. You can also remove the page
breaks you insert.

Show Page Breaks

Click on this command to see where the currently displayed text (result list or entry) will have page
breaks.

Save to File

Click on this command to save the report to a file on your computer.

See also:
Daily/Weekly Entry Report

Delete Entries

Entries can be deleted either one at a time from the category's "tree", or in batches using the Delete
Entries... command on the Entry menu.
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4.6
4.6.1

4.6.2

Once an entry has been deleted, it cannot be recovered.
Export/Import

Export/import Overview

The Journal supports the export and import of entries via several formats.
Supported Formats

Text Files (.TXT)

Rich Text Files (.RTF)

HTML Files ((HTM)

Journal Export Files (.JNX)

Text files are simply text, such as files made with Windows Notepad. The only formatting in text files is
marking end of lines with carriage returns.

Rich Text files, also called RTF files, contain full text formatting information. Font, paragraph
alignment, colors, and so on, are all preserved. RTF files can be read by most Windows word
processors.

HTML files are text files with "hypertext markup language" tags embedded. These tags control
formatting of the file when it displayed with a web browser, such as Internet Explorer. HTML files are
only supported when exporting. They cannot be imported.

Journal Export (JNX) files provide a way to transfer categories and entries, with all formatting in the
entries, as well as other category and entry information, between different installations of The Journal.

Exporting

The Journal supports a number of exporting options. You can export a single entry, an entire category,
or a collection of entries from multiple categories.

Select Categories/Entries to Export
Active Entry

Only the active entry will be exported.
Current Day (in all Standard Categories)

The entry for the current date in all standard categories will be exported. No loose-leaf entries will be
exported with this option.

These Categories/Entries

Whichever categories or entries you select will be exported. Entire categories can be selected for
exporting, or groups of entries spanning several categories.

Select Export Format

Rich Text (.RTF) - Rich Text, or RTF, files include all text formatting and embedded images/objects.
RTF files can be read by nearly all Windows word processors.

Plain Text (.TXT) - Entries exported to plain text files are stripped of all formatting except line-breaks.
TXT files can be read by any text editor and all word processors.

© David Michael. All Rights Reserved.



57

The Journal

4.6.3

46.4

HTML (.HTM) - HTML is the standard format of the World Wide Web. They can be edited by any text
editor, most Windows word processors, and, or course, they can be displayed with any Web browser.
Most text formatting is preserved, though not all. Embedded images are extracted to JPG files and
linked from the exported .HTM file.

Journal Export Format (.JNX) - The Journal Export Format is a proprietary format used only by The
Journal. It preserves not only all text formatting, but it also preserves all category and entry settings.
JNX files are used primarily to transfer entries from one copy of The Journal to another.

See User Preferences: Export for more information.

Importing

Text files (.TXT), rich text files (.RTF), HTML files (.(HTM;.HTML;.SHTML), and Journal Export files
(.JNX) can be imported into The Journal.

Text files, rich text files, and HTML files are imported into the currently selected entry. The imported file
is always appended to the existing entry. Only a single file can be imported at a time.

JNX files offer many more importing options. Entire categories can be imported, with all entries, or
single entries can be selected and imported into any existing category (of the same type).

When importing entries, it is possible to only import those entries that are newer. This provides a
simple mechanism for synchronizing entries between installs of The Journal.

To import multiple files at once, see Batch Entry Import.

See User Preferences: Import for more information.

Importing Entries from Other Journal Software

Many people, myself included, have kept their personal journals using other software.

There are several ways of importing these previously existing entries. Which method to use depends
on your circumstances: which software was used, how the entries are saved, etc.

Batch Export/Batch Import

The most convenient method is to use the other software's export capability and The Journal's import
features.

Export your entries from the other software into individual text (.TXT), rich text (.RTF), or HTML
(.HTM;.HTML) files. If the entries are for a particular day, make sure the date is used in the name of
the exported file. The best date format will use a 4-digit year, a 2-digit month, and a 2-digit day.

Example:
1993-10-05.RTF (entry for 5 October, 1993)

Once you have the entries exported, start The Journal. On the Tools menu, choose Batch Entry
Import... to import the entries into The Journal.

See Batch Entry Import for more information.

Copy-and-Paste Method

If the software you were using does not support exporting files, but was a Windows program, then this
method will work. It's not the most efficient method, but it's the same way yours truly (the author)
"imported" 3 years of entries made in Microsoft Word documents (one document per month).
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1. Launch both the original software and The Journal.

2. In The Journal, select the Category to receive the imported text. Then use the calendar and choose
the appropriate entry date, or create the new entry.

3. Use the Windows Taskbar (or Alt-Tab) to bring up the original software.

4. Select the text in the original software that you wish to import into The Journal, and then copy the
text to the Windows clipboard (Edit | Copy).

5. Use the Windows Taskbar (or Alt-Tab) to bring up The Journal and paste the text in the active entry
(Edit | Paste or Ctrl-V).

6. Repeat until all of the desired entries from the old software have been entered into The Journal.
4.6.5 Batch Entry Import

Many journal software products support exporting your entries in that software to a collection of text
(*.TXT), rich text (*.RTF), or HTML (*.HTML) files. With the Batch Entry Import form, you can import
those files directly into The Journal.

Importing into a Standard Category

To be imported into a standard category, the entry files must all use a standard naming convention.
The date of the entry must be included in the file name. The best date format will use a 4-digit year, a
2-digit month, and a 2-digit day.

Example:
2001-05-01.RTF (entry for 1 May, 2001)

Importing into a Loose-Leaf Category

When importing into a loose-leaf category, no special naming convention is required. The name of the
imported entry file will be used as the name of the entry.

4.6.6 Synchronizing Journal Volumes

It is possible to keep entries across multiple Journal Volumes "in sync" using the export and import
features of The Journal.

Synchronizing a Category
The easiest way to handle synchronization is at the category level.
1. Using The Journal's export feature, create a JNX file containing the entire category (all entries).
1.a. On the Entry menu, choose "Export Entries..."
1.b. Click on "These Categories/Entries" in the entry tree displayed.
1.c. Click on the category to export. This automatically selects all entries in that category.
1.d. In the Select Export Format, choose "Journal Export Format (.JNX)".

1.e. Click on "Export" to create the export file.
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2. To synchronize a category with the JNX file, make sure your import options are set to only import if
newer.

2.a. Click on the Options menu and choose "User Preferences..."
2.b. Bring up the "Import" tab.
2.c. Check "Only Import if Newer".

2.d. Click on "Done".

3. Import all newer entries in the category.
3.a. Click on the Entry menu, choosing "Import Entries..."
3.b. Select the .JNX file to import.
3.c. Check the category to import.
3.d. Click on "Import New"
3.e. You may be prompted to choose the category to import into. If the category already exists,
choose that one. Otherwise, click on "Auto-Create".
4. To update the JNX file, export the category, overwriting the JNX file.

Repeat the steps in #1 above.

In a future version of The Journal, this will be an automated process.
Synchronizing a User

Use the "Synchronizing a Category" process outlined above for all categories.

A single JNX file can be used, but then you have to be careful not to overwrite the JNX file until after all
categories have been updated.

4.7 Images

4.71 Images

The Journal lets you include images of all sorts in your entries: digital photos, animated graphics, and
icons (like Calendar Charms). You can also set images as backgrounds for your entries, much like you
can with a Web page.

Read more about using images in The Journal:

Using Images in Entries

Entry Background Images

Creating Your Own Borders
Calendar Charms

Creating Your Own Calendar Charms

Loading Images
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4.7.2 Using Images in Entries

Inserting Images

To insert images in your entries:

Click on the Insert menu and choose Insert Image...

You can also drag images from Windows Explorer and drop them into your entry.
Resizing Images

When you first insert an image into your entry, the image is resized to fit the entry editor. Click and drag
on the edges of the image to resize it.

If you would prefer to view the image at full size, right-click the image and choose Toggle Image
Full/Fit Window.

You can also double-click the image to toggle full size and back.

Image Descriptions

Images can be given descriptions. These descriptions are displayed when you hover the mouse over
the image. Also, you can do searches of image descriptions.

To give an image a description, or to edit an image's description:
1. Click on the image to select it.
2. Click on the Edit menu, and choose Edit Image/Object Description (hot-key: Ctrl+Shift+D).

Searching Image Descriptions
To search through the descriptions of all images in The Journal:

1. Click on the Search menu, and choose Search Entries... (hot-key: Ctrl+Shift+F)

2. Enter the word or words you want to search for in Text to Search for.

3. Un-check: Search entry text and Search entry names (this will force the search to look only in
image descriptions).

4. Click on Search.

4.7.3 Entry Background Images

There are two primary types of entry background image: borders and backgrounds. Borders are
graphics that run along the borders (left, top, right, and/or bottom) of the entry editor. Example:

& Daily Journal Motebook T
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4.7.4

Backgrounds are visible behind the whole entry, not just along the borders. Example:

£ Daily Journal Moteboaok T

Setting the Entry Background Image

To set the background of the current entry: Click on the Entry menu, find the Entry Background
Image sub-menu, and choose the background you want to use.

You can also set the entry background image to:

o Default - use the background image specified by the category, or the global setting.

¢ No Background Image - forces the entry to have no background image. This overrides the category
and global settings.

The Journal includes a number of entry background images, but you are not limited to those. You can
create your own!

Creating Your Own Borders

Creating Your Own Borders

Borders are simple to create, especially if you limit your borders to the left hand side of the entry.

& Daily Journal Motebook T

1. Select or create a small pattern that repeats itself vertically (like the daisy on pink pattern above).

2. Extend the image to the right with solid white (or other color) to a width of at least 1000 pixels. If you
have a high-resolution display, you might want to extend to 1500 or 2000 pixels.

3. Save the image to a JPEG (.JPG) file. JPEG images are compressed, so they take up a lot less
space in The Journal's database.

Loading Your Border Image
1. In The Journal, click on the Options menu and choose User Images...

2. Click on Load Image, and select your new image.
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3. Set the image type to: Background Image

4. Set the "Position" to: Tile

5. To make sure that the entry text doesn't overlap the border pattern, click on Margin Offsets...

6. Un-check: Equal Values

7. In Left enter the number of pixels wide the pattern is (the daisy pattern sets the left margin to 30).
And that's all there is to it!

Once you have added the image, you can make it a default background in your categories (Category
Properties..., Entry Text Style tab), or apply it to specific entries (Entry menu, Entry Background
sub-menu).

4.7.5 Creating Your Own Backgrounds

Creating your own backgrounds is at once simpler than borders and more complicated. Simpler
because if you use a digital photo then you don't have to worry about the image tiling (though you could
still do that), and more complicated because you have to make sure you can read text against the
background.

& Daily Journal Moteboaok T

Arrived in Singapor
to bed soon.
10am now. I've eatel

Here are some hints for creating your own background images:

e Open Space is Good - If you are using a digital photo, pick one that has a lot of open space in the
middle of the image. Pictures of the sky and ocean are good examples. You can have palm trees or
other objects along the left side and/or bottom to set the location and the mood, but try to keep the
middle clear.

o Keep it Simple - Expanses of sky and water are very simple backgrounds, making it easy to read
text against them. If you really must have that brook bubbling over many-colored rocks, then:

o Experiment with Masking - Most image handling software will allow you to mask or "washout"
images making them seem dreamier or more cloud-like. This can make it much easier to read text
over those images. Or:

o Experiment with Font Colors - Maybe if you switch away from dark/black fonts to lighter/white fonts
you will be able to read text shown over the image.

¢ Use JPEG Images - You can use either Windows Bitmap file (*.BMP) or JPEG compressed files
(*.JPG) for your backgrounds. JPEG files are usually much more compact, so you should choose
those when you can. Fortunately, most digital cameras create JPEG files automatically.
Loading Your Background Image

1. In The Journal, click on the Options menu and choose User Images...

2. Click on Load Image, and select your new image.
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4.7.6

4.7.7

3. Set the image type to: Background Image

4. Set the "Position" to: Center

5. If you want to adjust the text margins, click on Margin Offsets...
6. Check: Equal Values

7. Set the offset you want from the edges of the entry editor (most of the time, you will use values from
10-50).

And that's all there is to it!
Once you have added the image, you can make it a default background in your categories (Category

Properties..., Entry Text Style tab), or apply it to specific entries (Entry menu, Entry Background
sub-menu).

Calendar Charms

Calendar Charms are small icons that you can use to mark special entries. Mark good days, mark bad
days, mark appointments, mark holidays, and more.

Calendar Charms are displayed on the calendar, as well as in the "entry tree". Every entry can be
marked with a Calendar Charm, in standard (daily) categories and even in loose-leaf categories.

Calendar Charms can also be inserted into your entries as you type much like emoticons.
Setting (or Changing) an Entry's Calendar Charm

Menu: Entry | Set Entry Calendar Charm
Hot-key: Ctrl+F2

Removing an Entry's Calendar Charm

To remove the Calendar Charm from an entry, do this:

1. Bring up the Set Entry Calendar Charm form (Ctrl+F2).
2. Click on Clear.

Inserting a Calendar Charm in an Entry
Menu: Insert | Insert Calendar Charm
Hot-key: Shift+F2

Creating Your Own Calendar Charms

Calendar Charms can be single images, but are most often collections of small icons arranged in a
grid.

Here are some tips for creating your own Calendar Charms:
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4.8
4.8.1

¢ Grid layout - Arrange the icons in a simple grid (don't actually include grid lines), with every icon the
same size.

¢ Think small - If you want to use the icons on the calendar (instead of just inserting them into your
entries), it's best if you limit your icons to 16x16 pixels or 24x24 pixels. Larger icons will be reduced
to fit the calendar, and they may not look as good.

e Transparency - Calendar Charms are assumed to be transparent. The color at pixel position (0,0)
will be made transparent when the icon is inserted or used on the calendar. The best transparency
colors are very bright and obviously not part of the image (like fuchsia in the example above).

o Use BMP Images - When you create your Calendar Charms, save them as Windows Bitmap files
(*.BMP). This way your images (and your transparency) remain crisp.

Loading Your Calendar Charms

1. In The Journal, click on the Options menu and choose User Images...

2. Click on Load Image, and select your new image.

3. Set the image type to: Calendar Charms

4. Set the "# of Charms Across (X)" to: (the number of icons across: 4 in the example above)
5. Set the "# of Charms Down (Y)" to: (the number of icons down: 3 in the example above)

And that's all there is to it!

Journal Volumes

Journal Volumes

A Journal Volume is an "entry database" for The Journal. A Journal Volume can contain one or more
user logins and all of their categories and entries.

The Journal supports multiple Journal Volumes, each in a unique folder on your PC. By default, The
Journal places all Journal Volumes in:
C:\My Documents\The Journal Volumes\

NOTE: If you have your Windows "documents" folder set to a folder other than "My Documents"”, The
Journal will use that folder instead.

Journal Volumes can be placed on any available hard drive, or even removable media like lomega's
Zip disks. Each Journal Volume must have a unique name.

Most users of The Journal will only need a single Journal Volume.

Journal Volumes provide a simple way to maintain multiple installations of The Journal, and to share
entries between them.

For instance, if you use The Journal at home and at work, you could create a "Home" and an "Office"
Journal Volume at both places. At home, you would use the "Home" Journal Volume, and at work you
would use the "Office" Journal Volume.

Using The Journal's backup feature, you could transfer your work entries home and into the "Office"
Journal Volume there without having to worry about overwriting your "Home" entries.
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In a future version of The Journal, synchronizing between Journal Volumes will be supported.

4.8.2 The System Database

The Journal's System Database is separate from any Journal Volume. The System Database is always
stored in the "System" folder under the folder where The Journal is installed.

The Journal's System Database stores the names and locations of all Journal Volumes, as well as
certain global settings.

WARNING: The Journal's System Database should never be restored on any computer other than the
one it is from.

4.9 Links
49.1 Links

The Journal supports hypertext-style links in document entries.

The easiest way to use links in The Journal is to click on the Insert and choose Insert Link...

There are three types of link: entry links, file links, and Internet links. Entry links are links to another
entry in The Journal. File links are links to files on your PC, or on your local network. Internet links are
links to web pages or email addresses.

Similar to a web browser, The Journal allows links to have a "tag" that is displayed for the link. For
example, instead of displaying the entry link this way: journal:Daily Journal[12/7/2000], the link could
have a tag such as "My Birthday Last Year".

The Journal supports both tagged and un-tagged links. Un-tagged links are usually typed in by hand.
The Journal detects these and highlights them. You can click on the link and it behaves normally.

Tagged links have to be created with the Insert Link command on the Insert menu.

4.9.2 Entry Links

Entry Links are special "hyperlinks" in The Journal to allow one-click "jumping" to another entry.

Entry links can be "tagged" to hide the link information behind more descriptive text.

Entry Links to Standard Entries
journal:Category Name[Entry Date]

Category Name - the name of the category where the entry is located. If Category Name is omitted,
then the entry is assumed to be in the current category.

Sub-categories should be clarified by including their parent categories first, separated by a backslash
("\"). If no path is given, then the first category with the given name is used.

Entry Date - the date of the entry (for daily categories). The default format for entry dates in links is:
YYYY\MM\DD (note the use of backslashes instead of slashes).

If you do not use the above format, then the date must be in a system-recognizable format. For users
in the US, the standard MM/DD/YY (or YYYY) format works. For users in the Europe, however, the
format would (usually) be DD/MM/YY (or YYYY).

The date must consist of two or three numbers, separated by the character defined as the "date
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separator” in your Windows Locale (in the US that's the slash / by default). The order for month, day,
and year is determined by the by your Locale as well (US default is m/d/y).

If the date contains only two numbers, it is interpreted as a date (m/d or d/m) in the current year.

NOTE: These are Windows Locale settings, and not related to the date format used in The Journal for
inserting dates.

Example:
journal:Daily Journal[4/9/2001]

Current Entry Date - If an asterisk ( * ) is used in place of the entry date, then the entry link will jump
to the current entry date in the category.

Example:
journal:Daily Journal[*]

Entry Links to Loose-leaf Entries
journal:Category Name[Entry Name]
;)c:urnaI:Categow Name[Entry Path]
Category Name - same as above.

Entry Name - the name of the entry. The Entry Name is not case sensitive. If a loose-leaf category has
multiple entries with the same name, then the first matching entry name is used.

Entry Path - the name of the entry, including the names of any "parents" of the entry, separated by a
backslash (\ ). For example:

journal:Notebook[Recipes\English Muffins]

"Notebook" is a loose-leaf category. "Recipes" is an entry with a sub-entry named "English Muffins."

Default Entry Link - If an asterisk ( * ) is used in place of the entry name or path, then the entry link
will jump to the current default entry in the category.

4.9.3 File Links

File links are links to files that on your PC or your local area network (LAN). When you click on a file
link, that file is opened.

The file link format is:
file://drive:\path\filename.ext

Examples:
file://C:\My Documents\Resume.DOC

If the file name or the path contains spaces, then you must use the Create/Edit Link form.

File links can be "tagged" to hide the link information behind more descriptive text.
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4.9.4 Internet Links

Internet links are web page addresses, email addresses, and so on.

Supported Internet link formats are:
Web Pages (http://www.webpage.com, https://www.webpage.com, or www.webpage.com)
Email Addresses (mailto:davidrm@davidrm.com or davidrm@davidrm.com)

Also supported are FTP (ftp://), Gopher (gopher://), telnet (telnet://) and news (news://).

Internet links can be "tagged" to hide the link information behind more descriptive text.

4.9.5 Create/Edit Link

The Create/Edit Link form can be used for either entry links, file links, or Internet links.

Link

This is the actual link information. For example:
journal:Daily Journal[12/7/2000]

Or:
http://www.davidrm.com

Link Tag

The link's "tag" is descriptive text that can be use to "hide" the actual link information. Only the tag is
visible, and clicking on the tag activates the link.

Using the examples above, valid tags would be:
My Birthday Last Year

Or:

DavidRM Software

If no tag is specified, the link is inserted into the entry just as if it had been typed.

410 Options
4.10.1 Global Options

These options apply to all users of The Journal on a PC.

Minimize to System Tray
If specified, The Journal will minimize to the Windows "system tray" (in the lower-left corner, by the

time display) instead of the taskbar. When The Journal is not minimized, The Journal will still have a
button on the Windows taskbar.

Keep The Journal On Top

If set, this option keeps The Journal as the top-most Windows application. The Journal will be "on top
of" any other programs also running.

Other Global Options

© David Michael. All Rights Reserved.



The Journal Reference 68

Auto-Login
Extended Security: Global Options

4.10.2 Auto-Login

If you would like to automatically log you in when you launch The Journal, use the Auto-Login option.

You have to confirm your password to activate Auto-Login.
NOTE: The Auto-Login option effectively bypasses The Journal's built-in security features.
In past versions of The Journal, Auto-Login was called "Single User Mode".

4.10.3 Change User Password

Click on the Options menu and select Change User Password...

You will need to enter your current password (unless you have a blank password) to create a new
password. When your current password has been verified, you will be asked to confirm your new
password.

The Journal allows passwords of any length.

See Choosing a Good Password for tips on how to make your password as secure as possible.

Using a Blank Password

The Journal allows you to have a "blank" password if you want. If you do not want a password, but still
want The Journal to "prompt" you to login, a blank password will do that.

When you set your password, just leave the new password blank. Do not type anything.

4.10.4 User Preferences
4.10.4.1 User Preferences Overview

Each user of The Journal can customize The Journal to fit her own tastes and preferences.

Styles
Date/Time

Links

Spell Checker
Printing
Export

Import
Security

4.10.4.2 User Preferences: General

Measurement System

The Journal supports either the US system (inches, etc.) or the Metric system (centimeters, etc.). The
Journal automatically uses the measurement system settings active in Windows. If you wish to change
it, use this option.
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4.10.4.3

Start New Entry Date After

This is the time after which The Journal considers a new entry date to have begun in standard (daily
entry) categories. The default is midnight (12:00 am or 00:00).

Display Start of Week on

This is the day that is shown as the first day of the week on the calendar. The default is Sunday.
Auto-Save Every nn Minutes

This option tells The Journal to automatically save all changes at a specified interval.

Keep All Active Standard Categories on the Same Date

If checked, this option keeps all standard (daily entry) categories on the same entry date. That is, if the

date is changed in the current standard category, the same date is set for all other active standard
categories.

Show Category Type on Tab
If checked, the tab for each category will include a picture (icon) representing the type of category.
Show Entry Date/Name above Category Tabs

If you do not want the date or title of the entry above the category tabs, un-check this option.
This is useful if you are using a lower-resolution setting and need more screen "real estate.”

The Journal Global Windows Hot-Key Active

If checked, then The Journal can be activated (so long as it is running) regardless of where you are in
Windows, and what other applications may be running.

To set the global hot-key for The Journal, click on the hot-key entry. Then hold down the keys you want
to use for the hot-key.

The Journal's default hot-key is: Ctri+Alt+J

If you change the hot-key, you will want to test to make sure that none of your other Windows
applications are using the same one.

Countdown Timer Completed Sound

This is the sound played when the countdown timer reaches 00:00:00. This can be any sound (.WAV)
file on your computer.

User Preferences: Global

These options affect all users in all Journal Volumes on this computer.
Show The Journal "splash screen" on Startup
Un-check this option if you do not wish to see The Journal's opening screen when starting The Journal.

Start The Journal with Windows
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If this option is checked, The Journal will be started automatically whenever Windows starts.

Edit Category Tab/Entry Tree Font

Use this option to control the font used in the category tabs and in the entry tree. For example, if you
want to use a larger font size, to make the tabs and tree easier to read, you can do that here.

4.10.4.4 User Preferences: Editor

Default Tab Width

The default tab width is either 0.50 inches (US) or 1 cm (Metric). If you want it to be some other value,
you can specify that here.

When selecting, auto-select entire word

When using the mouse to select text in an entry, this option causes the selection to always pick up full
words.

Auto-Replace while Typing

If active, this option causes specified sequences to be replaced by text. The replacement text can be
either formatted or unformatted.

Edit Auto-Replace Strings

This button brings up the Edit Auto-Replace Strings form so you can edit, add, or delete auto-replace
strings.

Auto Symbol Replace while Typing

If active, this option causes specified sequences to be replaced by a symbol. For example, '(c)' would
be replaced by '©'.

Edit Symbol Replace Strings

This brings up the Edit Symbol Replace Strings form where you can edit, add, or delete symbol
replacement strings.

Symbol replacements are designated by:

e string to replace (Example: :-))

o font to pull the symbol from (Example: WingDings)
¢ symbol to replace with (Example: ©)

Do not automatically paste HTML (Paste HTML as Rich Text)

By default, The Journal pastes HTML that has been copied to the Windows clipboard. If you would
prefer that the copied HTML be pasted as Rich Text Format, check this option.

Edit Custom Colors

Use this option to set up to 16 custom colors that will be available wherever The Journal allows a color
to be set or selected.
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Default Editor Background Image

This is the image that is used as the background for all entries. This setting can be overridden at both
the category level (see Category Options: Entry Text Style) and at the entry level. Images must be
loaded using the User Images form (on the Options menu).

Automatic Image Resizing

For most journaling and scrapbooking purposes, images, especially digital photos, don't need to be
stored at their full size. However, having to reduce the images before putting them in The Journal can
be inconvenient. This feature makes it possible to have your images automatically resized when you
insert them.

Resizing can be fully automatic, or you can have The Journal prompt you.

The images are resized according to their largest dimension. If the image's width is greater than its
height, then the Resize if Width > (greater than) setting is used to scale the image. If the height is
greater than the wide, then the Resize if Height > (greater than) setting is used.

The image is resampled during the resize, so that the quality of the image remains high. The
resampling uses the Lanczos resampling algorithm with a 6x6 cell size.

4.10.4.5 User Preferences: Topics

Default Topic Highlight Color

This is the highlight color used by all topics. This color can be overriden by each topic, so that special
topics get more a distinctive color.

Topics

This is the list of all the topics you have defined. The Journal automatically creates nearly 100 topics
for you. You can add new topics, delete topics you don't want, and edit topics that need changing.

Topics that you have used in an entry are indicated in bold text.

Topic Name
Every topic must have a unique name.

By convention, topics are named with this format:
Topic: Sub-topic

You don't have to name your topics this way, of course.

NOTE: If you change the name of a topic that you have used in an entry, you may not be able to
search on that topic.

Highlight

To make it easier to distinguish topics used in an entry, you can set the highlight color. If you do not set
a color, then the default topic highlight color is used.

Hot-Key
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Up to 10 topics can be assigned a hot-key. Giving a topic a hot-key makes it even easier to apply that
topic. The available hot-keys are Shift+Ctrl+1, Shift+Ctrl+2, up to Shift+Ctrl+0.

Delete Topic

NOTE: If you delete a topic that you have used in an entry, you will not be able to search on that topic.

4.10.4.6 User Preferences: Styles

Edit Default User Text Style...

The default user text style defines the font and background color used in newly created categories, as
well as those categories still tied to the default settings.

User Styles

The Journal allows you to create as many pre-defined styles as you want. These styles can be used in
entries in any category.

Some styles are automatically created for you when you first start using The Journal. These can be
changed or even deleted, if you like.

Show Standard Styles

The Journal uses certain "standard" styles. Such styles are the default user text style, the bullet style,
and the numbered list style. Check this option if you would like to see those styles.

These styles can be edited and copied, but they cannot be deleted.

See Styles for more information.
4.10.4.7 User Preferences: Reminders

Click here for more information about reminders.

Reminders to Show Above Entry
You can set the list of reminders above the entry editor to show as few as 1 or as many as 25
reminders. If there are fewer reminders, the list is adjusted to fit so it doesn't get in the way. If there are

no reminders, then the list is hidden. If there are more reminders, then a scroll bar can be used to see
the rest of the reminders.

Report Missed Reminders

If checked (the default), then every time you log in, The Journal will see if you missed any reminders
since the last time you logged out.

Include Reminders When Printing/Exporting Entries
NOTE: This option only applies to entries in standard categories, like "Daily Journal".

If this option is checked, then when you print or export entries from standard categories, any reminders
that were active, completed, missed, skipped or canceled on that date will also be printed or exported.
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4.10.4.8 User Preferences: Date/Time

"Insert Date" Format
This is the format that is used for dates inserted with the Insert | Date (Ctrl+D) command.

Use the following codes for the date format:
yyyy - 4 digit year (1996)

yy - 2 digit year (96)

mmmm - full month name (August)
mmm - three-letter abbreviation of month (Aug)
mm - 2 digit month (08)

m - 1-2 digit month (8)

dddd - full day name (Friday)

ddd - three-letter abbreviation of day (Fri)
dd - 2 digit day (09)

d - 1-2 digit day (9)

Edit "Insert Date" Style
The formatting of the inserted date text can be specified with this option.

See Styles for more information.

Entry Date Header Format
This format is used to display the date above the entry.

See "Insert Date" Format above for formatting codes.

"Insert Time" Format
This is the format that is used for dates inserted with the Insert | Time (Ctrl+T) command.

Use the following codes for the time format:
hh - 2 digit hour (02:00)

h - 1 digit hour (2:00)

nn - 2 digit minute (2:03)

n - 1 digit minute (2:3)

ampm - 12-hour clock, AM/PM (2:00 PM)
am/pm - 12-hour clock, am/pm (2:00 pm)
alp - 12-hour clock, a/p (2:00 p)

Edit "Insert Time" Style
The formatting of the inserted time text can be specified with this option.

See Styles for more information.

4.10.4.9 User Preferences: Links

Auto-Highlight Links
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If checked, then Internet links/URLs (web page addresses, email addresses, etc) and entry links will
be highlighted as they are typed in.

Clicking links opens a New Browser

If checked, a new browser window is opened when Internet links are clicked on. If not checked, then
the most recently opened browser window is used. In either case, if no browser window is open, one is
opened.

Edit Internet/Email Links Style

The formatting used to display Internet links/URLs can be specified with this option.

See Styles for more information.
Edit Entry Link Style
The formatting used to display entry links can be specified with this option.

See Styles for more information.

4.10.4.10 User Preferences: Spell Checker

Check spelling as you type
This option performs "live" spell checking if activated. Misspelled words will be marked with a

distinctive underline (see Spelling errors underline color below). Marked words can be right-clicked
on to bring up a list of suggestions to correct the misspelling.

Spelling errors underline color

This option specifies the color used when marking misspelled words when performing "live" spell
checking.

Correct spelling errors as you type

This option performs "auto-correction" of designated misspellings. For example, "teh" is automatically
corrected to "the".

The Journal includes a list of commonly misspelled words and their automatic corrections. To edit, or
disable, this list of words, click on the Dictionaries... button and then Edit "autocorrect.adu".

Ignore words...
These options allow to specify words to that the spell checker should ignore.
Suggest from main dictionaries only

If checked, the spell checker will only suggest words from the active dictionaries. Custom dictionaries
will not be checked against.

Prompt on repeated word

Check this option if you want the spell checker to consider repeated words as a possible mistake.
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4.10.4.11 User Preferences: Printing

User Name

This option defaults to your login name for The Journal. If you would like your full name to appear on
entry printouts (using the <USERNAME/> macro), enter that here.

Edit Default Page Setup

The default page setup is used when printing entries from any category that does not specify its own
page setup. You can specify the default page orientation (portrait or landscape), as well as the margins
to be used.

Edit Default Page Header and Footer

The header and footer specified here are used when printing any category that does not specify its own
header and footer.

Edit Default Entry Header

The entry header specified here is used when printing entries from a category that does not specify its
own entry header.

See Printing for more information.

Print Loose-leaf Entry Index Indented

If checked, then printing an entry index (just the entry names) of loose-leaf entries uses tabs to show
the "tree-structure" of the entries.

For example:

My MemoryGrabber
About Me
Background Information
My Life's Timeline
My Childhood Years
Early Childhood
Eary School Years

If un-checked, then loose-leaf entries are printed with their full path and entry name.
For example:

My MemoryGrabber

About Me

About Me\Background Information

About Me\My Life's Timeline

About Me\My Childhood Years

About Me\My Childhood Years\Early Childhood
About Me\My Childhood Years\Eary School Years
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4.10.4.12 User Preferences: Export

Export Format: Default Export Format

Rich Text (.RTF) - Rich Text, or RTF, files include all text formatting and embedded images/objects.
RTF files can be read by nearly all Windows word processors.

Plain Text (.TXT) - Plain text files are stripped of all formatting except line-breaks. TXT files can be
read by any text editor.

HTML (.HTM) - HTML is the standard format of the World Wide Web. They can be edited by any text
editor, most Windows word processors, and, or course, they can be displayed with any Web browser.
Most text formatting is preserved, though not all. Embedded images are extracted to JPG files and
linked from the exported .HTM file.

Journal Export Format (.JNX) - The Journal Export Format is a proprietary format used only by The
Journal. It preserves not only all text formatting, but it also preserves all category and entry settings.
JNX files are used primarily to transfer entries from one copy of The Journal to another.

Use The Journal 3-compatible entry export - If checked, the JNX export will be compatible with The
Journal 3. Some formatting options might be lost or adjusted (examples: tables and images), since The
Journal 3 used very different text formatting.

Use The Journal 4-compatible entry export - If this option is checked, the JNX export will be
compatible with The Journal 4.0. The only difference is that the JNX file will not be Zip-compatible.

Export Format: RTF/TXT/HTM File Options

Create a Single File for all Exported Entries - This option creates a single file for all exported
entries. Categories are given "headers" to separate their entries.

Create a File for each Exported Category - This option creates a file for each exported category.
Only entries exported from that category are included in its file.

Create a File for each Exported Entry - This option creates a file for each exported entry. Depending
on the number of entries exported, this option could result in a lot of files being created.

Export Format: Use .HTML Extension

If you would prefer that entries exported as HTML use the .HTML file extension instead of the .HTM file
extension, check this option.

Export Format: Save HTML with CSS information in .htm(l) file

By default, The Journal saves CSS (cascaded style sheets) information in your HTML files. If you
would prefer to export your HTML with the older, inline tags, un-check this option.

File Names: Category File Name

If the Create a File for each Exported Category option is used, this setting controls the name of the
export file.

To include the name of the category in the file name, use the "%c" flag.

File Names: Entry File Name
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If the Create a File for each Exported Entry option is used, this setting controls the name of the
export file.

To include the name of the category in the file name, use the "%c" flag. To include the name (or date)
of the entry, use the "%e" flag.

File Names: Include "Full Path" in Loose-Leaf Entry Names

If checked, loose-leaf entry names include their full "path" of parent entries.

File Names: Export Path Separator

If exported loose-leaf entries will include their full path, it is necessary to specify a replacement for the
backslash (\ ) character in the path. The backslash (\) is not allowed in Windows file names.

This option is also used with the Entry | Save Entry As... command.

File Names: Date Format

For categories with entries tied to a date, such as standard categories, this setting controls how the
date is formatted in the export file name.

See Export/Import for more information.

4.10.4.13 User Preferences: Import

Category Import Options

Confirm All Import Categories - If checked, this option prompts the user before importing any
category, allowing the user to choose which category to import into. If this option is not checked, the
import process will attempt to automatically pick a category to import into based on the name and type
of the import category.

Auto-Create New Categories - If checked, the import process will automatically create any categories
that are in the import file but not already in the user's collection of categories.

Entry Import Options

Only Import if Newer - If checked, this option only imports entries if they are newer than the same
entry (based on date or entry name-and-path) already in The Journal.

Always Import - If checked, any existing entry in The Journal is overwritten by the entry being
imported.

See Export/Import for more information.

4.10.4.14 User Preferences: Security

Lock on Minimize

This setting, if active, "locks" The Journal when minimized.

Auto-Hide if Idle

If this setting is active, then The Journal automatically hides after the specified "idle" period.
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Lock on Hide

This setting "locks" The Journal when it is hidden, whether with the auto-hide option above or the "Hide
The Journal" hot-key (Ctrl+J).

Compress Entries

If checked (the default), all entries are compressed as they are saved. This keeps the Journal Volume
as small as possible, and adds a bit more security.

Encrypt Entries

If checked (the default), all entries are encrypted as they are saved. If compression is also turned on,
that happens prior to encryption.

Why you might turn off compression and/or encryption: If you use a lot of large (6+ megapixel)
images in your entries, you could increase the speed of saving your entries by turning off either
compression or encryption. Also, if you are not worried about the security of your entries, then you
might turn off these options to speed up loading and saving of entries.

NOTE: Turning off either does not affect entries that already exist. Only entries that are added or
modified will use the new settings.

See Extended Security: Global Options for more information.

4.10.5 User Images

The Journal allows you to load images for use as backgrounds to document entries or as
Calendar Charms.

Images

This is the list of all images currently loaded by the user. Each user login in The Journal has its own list
of images.

Load Image...

Click this button to load a new image.

NOTE: Every image must have a unique file name.
Delete Image

Delete the currently selected image.
Description

You can add a description to the image. This description is shown, along with the filename, whenever
you need to choose a background image for an entry or a Calendar Charm collection.

Image Type
An image is either a background image or a Calendar Charm collection.

Background Image Options
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Position

A background image can be either tiled across the entry, centered in the middle of the entry, or
stretched to fit the entry editor.

Margin Offsets

Click on this button to adjust the margins used with background image, for example to prevent text
from displaying on the border of the image.

Calendar Charm Options

Calendar Charm images are often collections of same-sized images arranged in a grid (but without
visible grid lines).

# of Charms Across (X)
The number of charm images across the image.
# of Charms Down (Y)

The number of charm images down the image.

4.11 Printing
411.1 Printing

The Journal supports a powerful collection of printing options. You can print a single entry, an entire
category, or a collection of entries from multiple categories.

NOTE: Only document entries and images can be printed by The Journal. External objects cannot be
printed. You will need to use the native application of the external object to print it.

Select Categories/Entries to Print
Active Entry

Only the active entry will be printed.
Current Day (in all Standard Categories)

The entry for the current date in all standard categories will be printed. No loose-leaf entries will be
printed with this.

Date Range (in all Standard Categories)

Entries will be printed for the specified date range in all standard categories. Entries will be printed in
category order, by date.

These Categories/Entries

Whichever categories or entries you select will be printed. Entire categories can be selected for
printing, or groups of entries spanning several categories.

See Printing Options and User Preferences: Printing for more information.
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4.11.2 Printing Options

Page Breaks

Between Categories

If checked, a page break will be inserted after every category.

NOTE: If no pages breaks are to be inserted between categories, and there are multiple categories

being printed, then the page setups, headers, and footers for those categories will not be used. Instead
the page setup, header, and footer defined in User Preferences: Printing (if any) will be used.

Between Entries

If checked, a page break will be inserted after every entry.

NOTE: This option can result in a /ot of paper being used. Use with caution.
Starting Page Number

By default, all printouts by The Journal begin with page number 1 (one). If you would like the printout to
begin with a different page number, you can specify that here.

Print Page Header

If checked, all pages will include the header for either the category or user (if one is specified).
Print Page Footer

If checked, all pages will include the footer for either the category or user (if one is specified).
Print Entry Header

If checked, all printed entries will be preceded by their entry name.

The page header and footer and the entry header are specified in User Preferences: Printing, or
Category Options: Entry Text Style.

Print Entry Index

If checked, then only the name of each entry is printed.
Force Text to Black & White

If checked, all text is converted to black and white.
Print Date Range

This option is only used when printing "Date Range (in all Standard categories)". For each date in the
given from/to range, each category will have its entry for that date (if any) printed.

4.11.3 Printing Headers and Footers

Headers and footers can be specified at the user level (see User Preferences: Printing) or at the
category level. If no header or footer is assigned to a category, then it uses the corresponding setting
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of the user.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom
of the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font
you have on your PC, you can use bold, italic, etc., and you can specify that the text be aligned to the
left, right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

Default Header

<CATEGORYNAME/>

[Bolded category name print macro, default font, left aligned]
Default Footer

Page <PAGENO/>
Printed on <PRINTDATE/>

[Bolded page number print macro above the date printed, default font, both centered]
Print Macros

Print macros are used in the headers and footers. They are used as "place holders" for values that
replace them when the header or footer is actually printed.

Text formatting (font, bold, italic, etc.) that is consistent across the print macro within the header or
footer is applied to the result of the macro.

The print macros are only processed when used in a header or footer. Any macros included in an entry
are not processed, only printed.

Print Macros

<USERNAME/> - the "User Name" specified in User Preferences: Printing

<USERLOGIN/> - the user's login name

<CATEGORYNAME/> - the name of the category currently being printed

<ENTRYNAME/> - the name (or date) of the entry currently being printed

<PRINTDATE/> - the current date

<PRINTTIME/> - the current time

<PAGENO/> - the page number of the page being printed

NOTE: The <ENTRYNAME/> macro uses the name of the entry that is being printed whenever the

new page is started. If there are multiple entries printing on a single page, the name of the first entry
printed on the page will be used. This applies to both header and footer.
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4.12.2

Reminders & Tasks

Reminders

With The Journal's reminders and tasks you can stay on top of your busy schedule.

There are four types of reminder: appointments, events, tasks and special days.

Appointments

Modern life can sometimes seem to be one appointment after the other. Appointments have both a
date and a time, and you can choose to have The Journal popup a visual and auditory prompt when its
time for the appointment, or up to 6 hours before hand so you can get an early start.

Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month, or every other
Friday).

Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks have a status: active, done, skipped, canceled, or missed.

Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

Appointments

Modern life can sometimes seem to be one appointment after the other. Appointments have both a
date and a time, and you can choose to have The Journal popup a visual and auditory prompt when its
time for the appointment, or up to 6 hours before hand so you can get an early start.

Date
You can click on the calendar to set the date of the appointment, or type the date in by hand.
Time

You will need to type in the time of the appointment by hand. You can also optionally include an end
time for the appointment.

If you want an appointment without a specific time, use an Event instead.

Popup Reminder

By default, the reminder will popup at the correct time on the date of the appointment. If you would like
a popup reminder before hand, you can set that as well, up to 6 hours in advance.

You can also assign a particular sound file (*.WAV) to be played when the reminder pops up.

By default, appointments are one-time events. To create an appointment that repeats daily, weekly,
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monthly, or even annually, look in Advanced Reminder Options.

4.12.3 Events

Similar to both special days and appointments, events can be daily, weekly, or monthly, and can even
occur at a particular time. The biggest difference between events and appointments is that events are
assumed to repeat on a regular basis (like the 2nd and 4th Wednesdays of each month).

Date
Use the calendar or type in the date of the event.

Events can also be set to happen every week on a particular weekday (Sunday-Saturday), every
weekday (Monday-Friday), on the weekend (Saturday & Sunday), or even every day. It's also possible
to alternate, setting the reminder to be every other week or every other day.

More complex dates can also be set, including:
Any day (or two days) of the week.

¢ Any weekday (or two weekdays) of the month.
¢ Any day (or two days) of the month.

¢ Any day (or two days) of the year.

Events set to a specific date are assumed to occur only once. Otherwise, events are assumed to
repeat. You can override both assumptions in Advanced Reminder Options.

Time

If you want to set a time for the event, you can type one in, as well as an end time for when the event
will conclude.

4.12.4 Tasks

Tasks are a special kind of reminder. Like events, tasks usually repeat, either every day, every week,
etc. Tasks have a status: active, done, skipped, canceled, or missed.

Priority

You can give the task a priority, which is used when listing the tasks above the entry editor. The higher
priority tasks are listed first.

Task Status

You can set the task to be active, done, skipped, canceled, or suspended. The "missed" status is set
automatically. When you first create a task, it's set to "active".

Active - The task is considered in progress.
Done - The task is complete. If this is a recurring task, it will switch back to active automatically.

Skipped - The task is incomplete and has been skipped for the current period (day, week, month,
year). If this is a recurring task, it will switch back to active automatically.

Missed - The task was incomplete at the time of its due date and marked automatically as missed. If
this is a recurring task, it will switch back to active automatically.

Suspended - The task has been put on hold. If this task had been a recurring, it will not automatically
occur again.
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4.12.5

4.12.6

Canceled - The task has been canceled. If this task had been a recurring, it will not automatically
occur again.

The task keeps a history of its status. This allows you to bring up a date and see those tasks for that
date which were marked as done, skipped, or canceled, as well as any tasks which were missed.

By default, tasks are displayed on the calendar and above the entry editor. If you have a number of
repeating tasks, especially tasks that repeat daily, you may want to use the
Advanced Reminder Options to turn off the calendar display for some tasks.

Special Days

Special days are birthdays, anniversaries, and holidays that we all want to remember--but sometimes
those days sneak up on us, and even sneak past us.

Birthday

For birthdays you can enter both the date of birth, and even the time of birth, if you so desire (and know
it).

If you know the year of birth, then the reminder for that birthday will be shown even when you're

reviewing past entries. If you don't know the year of birth, just use the current year, and the birthday will
show from this year forward.

Anniversary

Like birthdays, you can use the current year to be reminded from this year forward, or you can set the
actual year of the anniversary and see the reminder even in the past.

The default Calendar Charm for an anniversary is a bouquet of roses, but you can set that to any other
charm you wish, to remember anniversaries of all sorts.

Holiday

Holidays have a month and a day, and it's assumed you want to see the holiday every year, past or
future. If you want to set an effective date for a holiday, so that it doesn't show up before that date,
check out Advanced Reminder Options.

The drop down list of months includes information about some of the more common holidays, like New
Years, St. Valentine's Day, and Christmas. This information includes the month, day, and even a pre-
set Calendar Charm for that day.

Advanced Reminder Options

These advanced options are available for all types of reminders: special days, appointments, events
and tasks.

Name/Description

Every reminder needs a name. The name doesn't have to be unique, but it should convey the intent of
the reminder, since this is what you'll see most often.

Date/Time

Date - The date of the reminder can be a specific day, a repeating weekday or collection of days, or
some pattern of days within a week, month, or year.
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Time - The time of the reminder can be a specific time ("Eye Exam @ 7:00pm"), a start and end time
("Interview @ 9:00am-10:00am") or any time during the day ("Our Anniversary"). If you want to have a
reminder popup at you, you have to specify a time for the reminder.

This Happens - A reminder can be a one-time occurrence, or it can occur every day, week, month, or
year.

Effective Date - The effective date determines when the reminder becomes active. For example, if
you create a reminder for your wedding anniversary, you can set the effective date to the date of your
actual wedding. Every year after that, your anniversary will show on the calendar. You can also set an
end date, after which the reminder will no longer occur.

Display

Calendar Charm - Every reminder can be assigned a Calendar Charm. Default charms are chosen for
the different types of reminders, but you can change them to be whatever you like.

Show Reminder on Calendar - If checked, the reminder's Calendar Charm will be shown on the
calendar. If the same date has multiple reminders, only the top 3 will be shown, overlapping, on the
calendar. Since the calendar can get cluttered very quickly, you might want to limit the number of
reminders that show on the calendar.

Show Reminder above Entry - If checked, the reminder will be listed above the entry editor. You can
double-click the reminder when it's listed above the entry like this, and edit it.

Show Reminder - That Day Only - If checked, the reminder will show above the entry only on the
actual due date.

Show Reminder - N Days Before - If checked, then the reminder will show above the entry for the
specified number of days before the due date. Use this option to get advance warning of a reminder
coming due.

Show Reminder - Until Completed/Canceled - If checked, the reminder will always show above the
entry, until you cancel (or delete) the reminder, or mark it as done.

Popup

Popup Reminder when Due - If checked, and if the reminder has a specific time it's due, a reminder
will popup in The Journal.

Popup Reminder N Minutes Before - If checked, a popup reminder will happen the specified number
of minutes before the due time. The popup will include an option for you to be reminded again.

Play Sound on Popup - The default sound is the Windows "beep". You can specify any sound file
(*.WAV) you want to be played when the reminder pops up.

Status

Priority - A reminder can be given a priority from 1 (highest) to 100 (lowest). This priority determines
how the reminder is sorted when listed above the entry editor.

"Done" Charm - You can specify a different Calendar Charm to display when the reminder is marked
as done. The default is to use the same charm all the time.

"Skipped/Missed" Charm - You can specify a different Calendar Charm to display when the reminder
is marked skipped, or is missed.
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Status History - This is a listing of the reminder's status history. Most non-task reminders will show
the date they went active, and the date (if any) that they were completed. Task reminders, though,
especially recurring tasks, will accumulate a sequence of active, done, skipped, and missed statuses.
You cannot edit this information.

Categories

All Categories - If checked (the default), then the reminder is displayed, on the calendar, above the
entry, or both, in all categories.

Active Category Only - If checked, the reminder will be displayed only in the category active at the
time you created the reminder.

These Categories - If checked, you can specify which categories to display the reminder in. Note that
in loose-leaf categories, like "Notebook", you can see reminders on the calendar for other days, but
you will only be able to see above the entry reminders for the current date.

Notes

You can enter text of any length in the reminder notes, just like a normal entry.

4.12.7 View Reminders

The "View Reminders" form provides a list of all of your reminders, active, done, canceled, etc. The
reminders are categorized by their type: Appointment, Event, Task, or Special Day. The "All" tab can
be used to view all of your reminders of all types.

From this form you can edit, copy or delete reminders.

4.12.8 Daily/Weekly Reminder Report

Use the Daily/Weekly Reminder Report to view all of the reminders completed, canceled, skipped or
missed in a given date range: a day, a week, a month, a year, or any range at all.

Example:

You have various tasks that you want to perform daily. Each week you want to print out a report of how
you did the previous week. So you:

1. Click on the Reminders menu, choosing Daily/Weekly Reminder Report...

2. Select Last Week.

3. Click on See Report.

All of the reminders that were completed, canceled, skipped or missed over the past week are listed.
You can review them and then print a report, if you want.

Show all Reminders from:

There are 6 pre-set date ranges you can use: Today, Yesterday, This Week, Last Week, This
Month, and Last Month.

If you need a specific date range, click on This Date Range and set the From and To dates
appropriately.

Look In:
You can have the report created from the Active Category or All Standard Categories. Or you can

choose These Categories and select the specific categories to look in. Only reminders that are tied to
those categories (or are global reminders) will be reported.
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4.12.9 Exporting Reminders

The Journal supports exporting your reminders and tasks into a simple CSV (comma-
separated values) format that can be imported by other scheduling software, such as Outlook, Sunbird,
Mozilla, etc.

Reminders are exported as discreet events. That is, properties such as weekly and monthly recurrence
are not exported. Instead, the reminder will be exported once for each time the reminder would occur
within the specified date range.

Start Date & End Date

These dates provide the range of reminders and task to export.

Which Reminders

Special Days - If checked, special days will be included in the export file. Un-check this option to
prevent special days from being exported.

Appointments/Dates - If checked, appointments/dates will be included in the export file. Un-check this
option to prevent appointments/dates from being exported.

Events - If checked, events will be included in the export file. Un-check this option to prevent events
from being exported.

Tasks - If checked, tasks will be included in the export file. Un-check this option to prevent tasks from
being exported.

4.12.10 Importing Reminders

Reminders can be imported from any software that supports the simple CSV file format used by The
Journal. This format was created some time back by other software manufacturers, and has become
something of a universal format.

Reminders are imported as single events with a specific due date and time.

Some information exported from scheduler/planner software, such as required attendees, meeting
location, and so on, has no corresponding type of information in The Journal. However, in order to be
provide some degree of available of that information, they are imported and added to the "Notes" of the
reminder.

4.12.11 Export/Import CSV Format

The first line of the CSV file includes all field names in quotes. The data, one record per line, is all
string data.

Fields

[<<] "Subject" [>>]
[<<] "Start Date" [>>]
[<<] "Start Time" [>>]
[<<] "End Date" [>>]
[<<] "End Time" [>>]
[<<] "All day event" [>>]
[<<] "Reminder on/off" [>>]
[<<] "Reminder Date" [>>]
[<<] "Reminder Time" [>>]

"Meeting Organizer" [>>] (into Notes)

"Required Attendees" [>>] (into Notes)
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"Optional Attendees"  [>>] (into Notes)
"Meeting Resources"  [>>] (into Notes)
"Billing Information"

"Categories"

"Description" [>>] (into Notes)
"Location" [>>] (into Notes)
"Mileage"

"Priority" [>>] (into Notes)
"Private”

"Sensitivity"

"Show time as"

[<<] Exported by The Journal.
[>>] Imported by The Journal.s

4.12.12 Missed Reminders

This report displays reminders that were missed or had their due dates/times pass since the last time
you logged in.

413 Security

4.13.1 Security Overview

The Journal's security is designed to be as complete as possible while still offering a high level of
convenience. Also, The Journal's security is scalable, so you only have to use as much as you need.

Security Features and Options:
e Password protection

e Entry encryption

¢ Hide on minimize

¢ Hide hot-key

o Auto-hide onidle

e Lock on hide

The Journal also offers Extended Security, which must be purchased separately. Extended Security
provides more control over the login process, as well as makes The Journal's entry database that
much more difficult to "hack".

4.13.2 Levels of Security

Not everyone wants or needs the same level of security. The Journal's standard settings provide a
medium-to-high level of security, but if you want more security, or if you want the security features to
stay out of your way, The Journal can support you.

The level of security you will want to set is based on the level of threat you perceive and/or wish to

protect against. See the explanations for the different levels of threat that face an electronic journal in
the Levels of Threat help topic.

No Security

The Journal can support a near-lack of security if you want it to. With the Auto-Login option you can
have The Journal automatically log you in when it starts. See Auto-Login for more information.

The Journal also allows you to have a "blank" password.

Normal Security
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By default, a user must be created with a password. This password has to be entered before that
user's categories and entries can be accessed.

All entries in The Journal are compressed and encrypted before they are saved.

The Journal can be quickly "hid" (minimized) with this hot-key: Ctrl+J

Additional Security

The Journal can be "locked" when minimized or when hid, or both.

The Journal can automatically hide itself, locking itself if that option is also set, after a specified period
of "idleness". So if you get up and walk away from your PC, forgetting to hide and lock The Journal, it
will automatically do this for you.

See User Preferences: Security for more information.

Extended Security

For the Truly Paranoid, The Journal's Extended Security features provide a logical "next step" for The
Journal's built-in security. See Extended Security for more information.

Choosing a Good Password

Having a password is hardly useful if you don't pick a good one. Here are some guidelines for choosing
a good password (submitted by Bernard Beam):

6-10 characters in length (don't always pick the same length)

Use mixed-case alphanumeric(aBcD ...123..)

Try not to have more than 2 alpha characters in a row

Try not to have more than 3 numeric characters in a row

Don't use the correct spelling of a word

When using numbers, use them for more than just substitutes for letters (1 for 'I', 3 for 'e’, etc.)
Don't use the same password for multiple applications or purposes

Change your password every 30-60 days

In other words, "password1" is a particularly poor choice for a password. ;-)

A helpful mnemonic device is to select a phrase you will remember and use it as an acronym, for
example the phrase "l never forget to brush my gums" can create the password (In42bmg).

See Change User Password for more information.

Levels of Threat

All journaling software, including The Journal, faces the same kinds of "threats" to their security. These
threats range from "casual" access by novices to focused attacks by malicious hackers.

Casual or low level threats account for probably 80%-90% of the security issues faced by journaling
software. Fortunately, thwarting these requires very little effort from the developer. Medium level
threats, however, are a significant step up from low level threats, both in the training and technical
knowledge required to present these threats, and in the effort required to thwart them.

If a the journaling software can stop low level threats and medium level threats, then it has protected its
users from about 99% of potential "hackers".

High level threats represent dedicated hackers. They have the know-how and the tools necessary to
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analyze the data and the program, finding weaknesses in one or the other to exploit.

Very high level threats are (mostly) limited to large corporations and governments. Unfortunately,
there's very little that can be done to thwart threats of this level.

Low Level Threats

Casual access to journal entries via the software.

This threat is simply someone starting up the software either by double-clicking its icon on the
Windows desktop or by selecting it from the Start menu, and then perusing your entries.

This is an easy threat to thwart: Simply require a password.
"Over the shoulder" reading of entries.

If you are working in your journal, and someone walks up behind you, they will often look at your
computer screen. This is more out of habit than deliberate attempt to see what you're doing, but it's still
a threat.

Most Windows programs have a minimize button on their main title bar, so you can minimize the
program quickly. Or you can click on the Windows taskbar and overlay another application's form.
Another option is to provide a "hot-key" combination that quickly "hides" the journal program.

Medium Level Threats

Intentional access of journal database files.

This threat requires a bit more understanding of computer software. Simply put, the hacker opens up
Windows Explorer and takes a look at the files used by the journal software. If he recognizes the
database software that is being used, it's a simple matter of downloading the necessary system utilities
and opening up the database.

To thwart this, the journal software can either use a non-standard or proprietary database format, or
encrypt all revealing information, storing nothing "in the clear".

Password "hacking" from personal information.

The hacker acquires a few pertinent personal details about you and attempts to guess your password
based on that. Most people choose very poor passwords, using the names or birthdays of loved ones--
or even their own name and birthday.

Thwarting this threat is more the responsibility of the user than the software. Choose passwords that
are not simple words, and that have little or no personal significance. If possible, incorporate one or
two non-alphanumeric characters into your password. See Choosing a Good Password for more tips
about passwords.

High Level Threats
Analysis of data stored in database.

In addition to using the standard database software to examine the user and entry information, the
hacker goes one step further and looks at the raw data that is stored using either a "hex viewer" or
another piece of specialized software. This type of analysis completely eliminates any advantage that
the developer might have gained by using a proprietary database format. In addition, simple encryption
schemes will be obvious and, therefore, quickly cracked.
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Analysis of program code.

With sophisticated "debugging" and "tracing" software, the hacker examines the inner workings of the
software, looking for a way to bypass the entire security system of the software.

"Security by obscurity", which works well for low and medium level threats, is useless to combat high
level threats. The software developer has to anticipate this kind of analysis of both data and code.

The nature of journaling software, where you have to be able to get out what you put in, exposes
certain points of attack. An analysis of these points of attack is beyond the scope of this article,
however. Suffice it to say that it is vitally important for the software developer to be aware these
inherent weaknesses and do everything possible to make it difficult to exploit those weaknesses.

Very-High Level Threats
Advanced analysis of program code and data.

At this level, you are now dealing with hackers who have lots of time, top-of-the-line tools, and probably
a good amount of funding. The software can be pulled apart and all of its "parts" identified by function.
And every bit of data can be extracted and run through state-of-the-art cryptography software.

At this level of threat, there's nothing anyone can really do for you. Any claims to the contrary should be
treated with extreme skepticism.

How Does The Journal Stack Up?
So how does The Journal stack up against these different threats?

Against low level and medium level threats, The Journal is more than adequate. The Journal offers
password protection and quick-hide hot-keys, as well as automatic hiding after periods of idleness.
Also, The Journal compresses and encrypts all entry information, and no potentially sensitive
information is stored "in the clear" in the database.

The Journal would give a high level threat a good run for his money, | believe, though it would
eventually succumb. The Journal's Extended Security, however, raises the bar significantly higher,
possibly beyond the resources most high level threats could bring to bear on the problem.

If you are facing a very-high level threat, then neither The Journal nor any other journaling software
currently available will be able to help you. In fact, at this level of threat, it's probably a bad idea to
commit anything to electronic form, as nearly all electronic data can be retrieved.

Fortunately, the individuals with the skill and resources sufficient to pose high and very-high threat
levels have other things to do than hack someone's journal, unless of course you are an international
diplomat, William "Bill" Gates, or have stored National Secrets on your computer. In these cases, your
best bet is to contact the CIA's In-Q-Tel program for top-of-the-line electronic systems security items.

All'in all, The Journal represents an amazingly secure environment. And if you require an additional
level of security, The Journal's Extended Security can give you that.

Security Details

Passwords
Passwords in The Journal are never stored in the database without being "hashed".

Passwords are hashed with the MD5 algorithm produced by RSA Data Security, Inc. This is a one-way
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hashing algorithm, making it nearly impossible to guess the password from the hashed value.

Encryption

Entries stored in The Journal are always compressed before encryption. The compression removes
redundant information from the entry, making the encryption somewhat more secure.

Compression of entries uses the LZH5 compression algorithm (a Lempel-Ziv-Huffman algorithm)
programmed by South Pacific Information Services Ltd. This is very similar to the compression used by
the LHarc utility.

Encryption of entries uses the Twofish block cipher designed by Bruce Schneier. Encryption keys are
created using the intervals between certain keyboard and mouse events. The event intervals are
measured in 1/1,000,000ths of a second over a period of time and provide a reasonable amount of
"entropy" to keep them from being predictable.

Extended Security

If you need a higher level of security than The Journal normally provides, then the Extended Security
option may be what you're looking for. The Journal's Extended Security must be purchased separately.

User Extended Security

A login name that uses Extended Security is significantly more secure than normal. See the
Levels of Threat topic for more information.

NOTE: A login with Extended Security active cannot have its password reset. If you lose your
password, there is absolutely nothing that can be done to recover it.

Extended Security: Global Options

Extended Security: Global Options

These options are only available if The Journal's Extended Security has been purchased.

These options apply to all users of The Journal on a single PC.

Automatic Login Failure

With Extended Security, you can specify that all login attempts fail after a certain number of
consecutive failures.

For example, if someone is attempting to guess a user's password, then after the specified number of
failures, The Journal automatically fails all other attempts. The Journal doesn't even check the
password entered. The failure message is displayed, and The Journal prompts for the password once
again.

This option functions regardless of whether Extended Security is turned on for a particular user. Setting
any non-zero (0) number of tries activates this option.

Minimum Wait Time

Once the automatic failure option has activated, the user will have to wait the specified minimum time
before The Journal stops automatically failing attempts.
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414 Styles
4141 Styles
The Journal styles allow you to assign pre-defined font and paragraph settings to a block of text.

The Journal automatically creates the following styles for you:

Heading 1, Arial 14pt bold, 12pt before-spacing, 3pt after-spacing
Heading 2, Arial 12pt bold-italic, 12pt before-spacing, 3pt after-spacing
Heading 3, Arial 12pt italic, 12pt before-spacing, 3pt after-spacing

These styles can be edited or even deleted. They are provided primarily as an example of what styles
are capable of.

You can create as many styles as you like.
If you change a style that is already in use, the change will be visible in any existing entries.

See Style Options for more information.
4.14.2 Style Options

Style Name

Every style must have a unique name. You cannot change the name of the standard styles.

Style Hot-Key

Up to 10 styles can be assigned a hot-key. The available hot-keys are Ctri+1, Ctrl+2, up to Ctri+0.
Character: Font

The font setting determines which font is used for the style. This setting also determines the font's
point size, color, and any special effects (like bold, italic, etc) that are applied to the font.

Character: Highlight Color

The highlight color of the style determines the color that will be behind the text.

Style Options: Paragraph
Style Options: Override Options

4.14.3 Style Options: Paragraph

These style options affect the paragraph settings.
Apply Style to Paragraph Settings
This option must be checked for the style to affect the paragraph settings.

Background Color
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The color to be displayed "behind" the entire paragraph (not just the text).

Style Options: Paragraph: Alignment & Indents
Style Options: Paragraph: Spacing
Style Options: Paragraph: Numbering/Bullets

4.14.4 Style Options: Paragraph: Alignment & Indents

Alignment

This setting determines whether the text affected by the style is aligned to the left, center, right, or
"block". The "default" alignment does not affect the alignment of the text when applied.

Apply Style to Indentation

This option must be checked for the style to affect the paragraph indentation.
Left and Right

These settings affect the indentation from the left and right margins of the entry.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the standard form (inches for US, centimeters for Metric).

Special

This indentation can be applied to the first line of the paragraph (First Line) or the following lines
(Hanging).

NOTE: If this setting is used on a style that also sets bullets or numbering (see below), this value
overrides the "numbering indent" for lines after the first line of the paragraph.

4.14.5 Style Options: Paragraph: Spacing

Line Spacing

Line spacing for a paragraph can be single, 1.5, or double. This affects how the text is displayed, as
well as how it is printed.

Apply Style to Paragraph Spacing

This option must be checked for the style to affect the before and after spacing of a paragraph.
Before and After

These settings affect the line spacing before and after the paragraph.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the points.
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4.14.6 Style Options: Paragraph: Numbering/Bullets

Apply Style

This option must be checked for the style to use numbering or bullets.
Bullet/Numbering Type

None: No numbering or bullets on the paragraph.

Bullet: Standard bullet list.

Numbers: Numbered list (1, 2, 3, ...)

Letters: Lower-case letters (a, b, c, ...)

Letters: Upper-case letters (A, B, C, ...)

Roman: Lower-case Roman numerals (i, ii, iii, ...)
Roman: Upper-case Roman numerals (1, 11, 1ll, ...)

Numbering Style
Partial Parenthesis: 1) 2) 3) ...
Period: 1. 2. 3. ...

Full Parenthesis: (1), (2), (3) ...
None: 123 ...

Indent

This setting affects the indentation of the first line, after the bullet or number, and the rest of the
paragraph.

These values can be specified in inches (" or in), centimeters (cm), or "points" (pt). Whichever form is
entered, the value is converted to the standard form (inches for US, centimeters for Metric).

4.14.7 Style Options: Override Options

Use Default Font, Size, & Color

These settings forces the style to use the current category's default font, font size, and font color,
regardless of the style's font settings or font currently active in the entry.

Use Active Font, Size, & Color

These settings forces the style to use the current entry's active font, font size, and font color,
regardless of the style's font settings.

Blend with Active Font Effects (Bold, Italic, etc.)

This setting "blends" the style's font settings for bold, italic, underline, and strikeout with those of the
currently active font.

Apply No Font Formatting

This setting forces the style to always use the currently active font. This setting is useful for only
applying paragraph and numbering changes.

HTML Style
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4.15
4151

4.15.2

If checked, text with this style applied will export (to HTML only) '&', '<', '>', and multiple spaces as they
are.

This option is most often used when posting to blogs. Some blogs support special HTML-like tags. To
have those tags "passed through" to the blog as they are, apply a style with this option.

Tables
Tables

The Journal entries can include tables with a variable number of rows and columns. More than simple
grids, each table cell can contain formatted text with any number of paragraphs, including images and
even other tables. Tables can be nested to any depth. Further, table cells can be merged together to
create larger cells, both horizontally and vertically.

‘ Horizontally Merged Cells ‘
L] | | |
D Vertically A table in a table...
Merged | | |
% Cells | ” ‘

Tables in The Journal follow the HTML model. In this model, every cell in a table has its own distinct
border on all four sides. In addition, the table as a whole has a border, distinct from the cells in the
table. You can change this default look, however, and make the tables appear to have a single line
border between cells.

Tables and cells can also have background images, and these background images can be centered,
tiled, stretched.

The contents of table cells can be aligned vertically (to the top, bottom or middle of the cell), as well as
horizontally (left, right, and centered).

Another advantage of the HTML table model is that widths of columns are calculated based on the
widths of individual cells. Widths of cells (and the table as a whole) can be defined as percentage of
the visible editor, or a specific number of pixels. The height of cells can be set to match the content of
the cells, or can be set to a specific number of pixels.

And, of course, you can change the width and height of the table and cells with the mouse.

Using Tables

There are many uses for tables! One of those is demonstrated in the sample template: "Food Log".

Sunday 19 Sep, 2004

Total Fat
Time Food Amvount Calories | Calories
5:31 PM |Chips & Salsa |5 chips
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Uses for tables:
¢ Arranging information in an easy-to-reference grid
e Controlling text and image layout

Adding a Row to a Table

To add a row to a table (like the Food Log):
1. Click on a cell in the last row of the table.
2. Click on the Table menu and choose Insert Row Below.

Merging Table Cells

To merge table cells together:
1. Select the table cells you want to merge.
2. Click on the Table menu and choose Merge Cells.

Using Tables for Text Layout

You can use tables to control the layout of text and pictures. For example, you can use a table to put
text beside a picture.

. Click on the Table menu and choose Insert Table...

. Number of Columns: 2

. Number of Rows: 1

. Size Table Manually: 100 percent

. Click on the left table cell.

. Insert the image.

. Use the mouse to resize the left table cell to fit the image.
. Click on the right table cell.

. Enter the text to be beside the image.

OCoONOPAWN -

Hiding a Table's Borders

1. Click on the table.

2. Click on the Table menu and choose Table Properties...
3. Click on Table Border...

4. Border Type: None

5. Click on Cell Borders...
6. Border Type: None

4.15.3 Insert Table

Number of Columns
The number of cells across the table (left-to-right).
Number of Rows

The number of cells down the table (top-to-bottom).
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Columns

Rows

Table Layout

Autosize - The table is created as wide as the entry editor, with all columns the same size.

Size Table to Fit Window - The table is created as if you had entered "Size Table Manually" as "100%
percent".

Size Table Manually - You can set the table width to be a set number of "Pixels" or a "Percent" of the
entry editor window.

Table Properties...

Click here to adjust the properties the table will be created with: fill color, cell padding, borders, and so
on.

Remember Table Size & Properties for New Tables?

If checked, the current settings are remembered for the next time you insert a table.

4.15.4 Table Properties

To set or change a table's properties:

1. Click on any cell of the table.

2. Click on the Table menu, bring up the Select sub-menu, and choose Select Table.
3. Click on the Table menu and choose Table Properties...

Width

A table's width can be set one of 3 ways:

¢ As a percentage of the width of the document entry editor ("Percent").

¢ As a specific number of screen pixels ("Pixels").

¢ Using the mouse to click-and-drag the table wider or narrower ("Manual").

Fill Color

Tables can be either "Transparent" (showing the color of the entry), or any color of your choice. The
table's fill color is the default fill color of all of the table's cells (though each cell can have its own color;
see Table Cell Properties).

Cell Padding

Cell padding is the amount of space (in screen pixels) between the border of the table cell, and the
contents of the cell.

Cell Spacing

Cell spacing is the amount of space (in screen pixels) between the border of the table and the border
of the cells. It is also the amount of space between the individual cells.

Cell spacing can be broken down into vertical spacing between the table border and the cells,
horizontal spacing between the table border and the cells; and vertical and horizontal spacing between
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individual cells. You can adjust these values by clicking on More... on the Table Properties form.

Image...

A table can have a background image that is shown "behind" the table cells. The image can be tiled,
centered, or stretched.

Table Border...

You can set the color and highlight color of the table's border. You can turn off the border completely,
or have it displayed as sunken, raised, or flat.

Cell Borders...

You can set the color and highlight color of the table's cell borders. You can turn off the cell borders
completely, or have them displayed as sunken, raised, or flat.

Keep Table on a Single Page
The table will not be printed on multiple pages.

Count of Heading Rows

If the table is printed on two or more pages, these first rows of the table will be repeated as a header
on all pages.

See also:
How do | make my tables look like those in MS Word/WordPerfect/Etc?

Table Row Properties
Table Cell Properties

4.15.5 Table Row Properties

To set or change the properties of a row of a table:

1. Click on a cell in the row you want to change.

2. Click on the Table menu, bring up the Select sub-menu, and choose Select Row.
3. Click on the Table menu and choose Table Properties...

4. Bring up the Row tab.

Vertical Alignment
The vertical alignment of a table row can be set to either top (the default), center, or bottom.
This setting can be overridden at the cell level.

See also:
Table Properties
Table Cell Properties

4.15.6 Table Cell Properties

To set or change the properties of a row of a table:

1. Click on a cell in the row you want to change.

2. Click on the Table menu, bring up the Select sub-menu, and choose Select Cell.
3. Click on the Table menu and choose Table Properties...
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4. Bring up the Cells tab.

Preferred Width

This is the preferred width for the cell(s), in pixels or percents of table width. Cells can be wider than
this value, if required to display its contents without overlapping.

Height at Least

This is the minimum height for the cell(s), in pixels. Cells can be taller than this value, if required to
show all its contents.

Fill Color
This is the background color of the cell(s). This overrides the fill color of the table.
Image...

A table cell can have a background image that is shown "behind" the cell. The image can be tiled,
centered, or stretched to fit the cell.

Vertical Alignment

The vertical alignment of a table cell can be set to either top (the default), center, bottom, or default. If
set to default, the cell uses its row's vertical alignment.

See also:
Table Properties
Table Row Properties

416 Templates

4.16.1 Templates Overview

Templates allow you to use standard forms or blocks of text in your entries. Writing and journaling
prompts, worksheets and forms, and "boilerplate” text are all possible with templates.

A template is either "simple" or "enhanced". Simple templates are inserted without any processing,
exactly as they were created. Any loose-leaf entry can be a simple template. Template entries are
displayed in the entry tree with a red "T" (&) beside their name.

See Simple Templates and Creating Simple Templates for more information.

Enhanced templates provide many more options. Enhanced templates can be used to "create" entry
text that is then inserted into the current entry. An enhanced template can have one or more "sections"
that can be selected (at random or in sequence). An enhanced template can use other templates
(simple or enhanced) or even files external to The Journal.

See Enhanced Templates and Creating Enhanced Templates for more information.

Inserting a Template

Inserting a template is the same, whether it is simple or enhanced. You choose Insert Template from
the Insert menu (or from the right-click context menu) and then select the template you want. The
selected template is then added to the current entry.
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4.16.3

4.16.4

Simple Templates

Any loose-leaf entry can be a simple template.

When a simple template is inserted with Insert Template, the entire template entry is copied. All text
formatting is preserved.

To have an entry appear as a template in the Insert Template list, first select the entry. Then click on
the Entry menu, and choose Template Entry.

See Creating Simple Templates for more information.

Enhanced Templates

Enhanced templates are much more than just a text entry.

An enhanced template can have multiple "sections". When the template is inserted, only a single
section is selected and inserted into the entry. Which section is selected depends on how the template
is setup. It could be a random section, or the next section in the sequence.

With an enhanced templates ability to pull in other templates, simple or enhanced, they significantly
extend the "boilerplate" features of templates.

In addition, enhanced templates can use "scripting", such as VBScript or JavaScript, to provide even
more power. Scripting can prompt the user for information, or control the text that is ultimately
returned.

Example uses of enhanced templates:

Writing exercises, either in sequence or random
Journaling exercises

Inspirational quotes

Auto-generated notes and letters

Role-playing game (RPG) charts and tables

See also:

Creating Enhanced Templates
Enhanced Template Tags
Enhanced Template Script Variables

Enhanced Template Tags

<TEMPLATE {{METHOD="method"} {SCOPE="scope"}} {USE="uselLanguage"}
{UNFORMATTED}></TEMPLATE>

This tag must be the first non-whitespace of an extended template.
A single entry can include only one template.
Text in the document that is external to (follows) any defined templates is ignored.

METHOD specifies the default access method of the template. If unspecified, the default access
method is "sequence". Valid default access methods are "sequence" and "random".

SCOPE specifies how the "sequence" default access method stores the current point in the sequence.
Valid default scopes are "global" and "category". If no scope is specified, then "global" is used.
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USE specifies the default "scripting language" used by <DECLARE> and

<EXECUTE> tags. If not specified, the default scripting language is "VBScript". Other supported
scripting languages are "JavaScript", "PerlScript", and "PythonScript". VBScript and JavaScript are
usually available so long as you have Internet Explorer 4 or higher installed on your PC. The availability
of PerlScript and PythonScript is beyond the scope of this document. Generally, you will need to
download and install special software to use those.

If UNFORMATTED is specified, the selected section of the template is forced to be unformatted. This
overrides any formatting specified in the section.

<INCLUDE {ENTRY="entryName" {CATEGORY="entryCategoryName"}
{UNFORMATTED}}/>

<INCLUDE {FILE="fileName" {UNFORMATTED}}/>
<INCLUDE {URL="urlText" {UNFORMATTED}}/>

An included entry is specified external to any sections. By convention, included entries are generally
listed after any <DECLARE>'s with defined functions.

CATEGORY is used to include entries in other categories. If not specified, the entry must be within the
current category.

Any <DECLARE>'s in the included entry are treated as though they were declared in the including
template.

<SECTION>'s in included entries are added to the template according to their order in the included
entry. Included entries can be specified before, after, between, and so on, sections that are in the "top
level" template.

If an included entry includes other templates (and so on), the sub-includes will be handled recursively.
Duplicate entry includes, at the top level and within a <SECTION>, will be ignored.

<INCLUDE FILE...> is used to pull text (with or without formatting) into a template or <SECTION>. The
file is assumed to be text or text-with-markup. If no path is specified, the file will be looked for in the
active folder and then the default Windows path.

If the file has a .TXT extension, it is assumed that it will be unformatted text.

If the file has a .RTF extension, it is assumed to be rich text. If UNFORMATTED is specified, the file
will be included without formatting.

<INCLUDE URL...> is used to pull the contents of a URL into a template or <SECTION>. The URL can
specify a Web page, or an image.

<INCLUDE> can be used externally to <SECTION>'s, as well as within <SECTION>'s. The inserted
text will replace the entire <INCLUDE ... /> tag.

<INCLUDE>'s external to a <SECTION> will be processed every time the template is accessed.
<INCLUDE>'s internal to a <SECTION> will only be processed if that <SECTION> is selected.

If the included file causes incorrect formatting, or otherwise causes an error, accessing the template
will cause an error.
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<DECLARE {USE="useLanguage"}></DECLARE>

The <DECLARE> tag is used to define functions, procedures, and "global" variables that can be called
or accessed in other parts of the template.

<DECLARE>'s must be external to any <SECTION>'s. Thus, it is convention to place all
<DECLARE>'s at the beginning of the template.

An error in a DECLARE, for instance a syntax error in declaring a function or variable, will halt the
template.

Standard functions and procedures can be declared in a template with no sections. This template can
then be included in other templates. This allows a certain amount of "code re-use".

Variables declared in a <DECLARE> can be accessed by any <EXECUTE> in the template. However,
the value of the variable is not maintained from one <EXECUTE> to another.

If a template includes different <DECLARE>'s with different USE attributes, then each different
scripting language will have its own "run state". Elements declared for one scripting language will not
be available for use in other scripting language <DECLARE>'s or <EXECUTE>'s.

<EXECUTE {USE="uselLanguage"}></EXECUTE>
The <EXECUTE> tag allows the template to perform some processing as part of processing.

<EXECUTE>'s external to a section will all be executed prior to accessing any section of the template.
Template-level <EXECUTE>'s can return a block of text that is embedded in the template. Thus, these
<EXECUTE>'s can selectively add <INCLUDE>'s, <DECLARE>'s, and so on to the template.

<EXECUTE>'s can also be used inside sections. In that case, the <EXECUTE> is considered to have
a string-type result value (called "Result") that will be inserted into the section when the script is
finished. The text formatting of the initial <EXECUTE> tag will be applied to the inserted text. The
inserted text will replace everything between and including the <EXECUTE> and </EXECUTE>.
Processing of the template will begin again at the first position replaced. Thus, a <EXECUTE> could
create further tagging to be processed.

There are global variables that can be accessed from any <EXECUTE>, and any changes to those
variables are kept. These globals can hold just any kind of data. "Global[nn]", where nn specifies an
index into the global array.

An error in an EXECUTE, for instance a syntax error, will halt the template.

<SECTION {ID="id"}></SECTION>

The section's ID can be a single integer, or a range of integers. A range is specified as "nn-mm", and
includes the values nn and mm. mm must be greater than or equal to nn. By convention, sections are
arranged in ID order, least to greatest.

If no ID is specified for a section, then it is given an automatic ID relative to its position in the list of
sections in the template, based on the last ID specified. So if the first section ID was given as 100, the
next would automatically be 101, and so on.

It is possible for "blank" spots to occur in a template, where there is no section tied to a particular ID. If
one of these blank sections is accessed by ID, nothing is returned.
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Specifying a section which duplicates an earlier ID, or overlaps with a range specified for an earlier
section, will cause an error when accessing the template.

<SELECT ENTRY="entryName" {CATEGORY="entryCategoryName"}
{{METHOD="method"} {SCOPE="scope"} {DATA="data"}} {UNFORMATTED}/>

The SELECT tag can only be used within a section.

CATEGORY is used to select templates in other categories. If not specified, the template must be
within the current template's category.

METHOD specifies the how the template picks a section to return. If unspecified, the default access
method is "sequence"”. Valid access methods are "sequence", "id", and "random".

"random" access uses each sections ID range to determine that sections chance of being selected. So
a section with a wide ID range has a better chance of being selected than a section with a single ID.

SCOPE specifies how the "sequence" access method stores the current point in the sequence. Valid
scopes are "global", "template”, and "category". Default scope is "template".

"global" scope means that current sequence value is stored for the template being called. "template”
scope means that the sequence value is stored for the calling template and the template being called.
"category" means that the sequence value is stored for the calling category and the template being
called.

The DATA attribute is used by the "id" access method.

If UNFORMATTED is specified, then any formatting in the returned section is ignored.

<DATE {FORMAT="dd/mmlyy"}/>
<ENTRYDATE {FORMAT="dd/mm/yy"}/>
<TIME {FORMAT="hh:nn:ss"}/>

The text formatting of the date or time tag will be used on the inserted text.

DATE inserts the current system date. ENTRYDATE uses the date of the entry where the template is
being inserted into. In loose-leaf categories, ENTRYDATE functions the same as DATE.

If no FORMAT is specified, the Windows default setting for the date or time will be used.
The FORMAT's available include:

d,dd Day of the month, example: 3, 03
ddd Short day name, example: Tue
dddd Long day name, example: Tuesday
m, mm Month number, example: 6, 06
mmm  Short month name, example: Jun
mmmm Long month name, example: June
vy Short year, example: 03

yyyy  Long year, example: 2003

h, hh  Hour of the day, example: 7, 07
nn Minutes of the time

SS Seconds of the time
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4.16.6

&It; - replaced with '<' during section access.
&gt; - replaced with '>' during section access.

&quot; - replaced with "™ (double quote) during section access.

<LITERAL VALUE="string"/>
The literal quoted string is embedded in the template section replacing the LITERAL tag.

Enhanced Template Script Variables

The Journal provides some variables that can be used within the <DECLARE> and <EXECUTE> tags.
Result

If an <EXECUTE> is used inside a section the <EXECUTE> is considered to have a string-type result
value (called "Result") that will be inserted into the section when the script is finished. The text
formatting of the initial <EXECUTE> tag will be applied to the inserted text. The inserted text will
replace everything between and including the <EXECUTE> and </EXECUTE>. Processing of the

template will begin again at the first position replaced. Thus, a <EXECUTE> could create further
tagging to be processed.

Globalnn

"Globalnn", where nn specifies an index 1-1000 into the global array. Example variable names are:
Global1, Global23, Global456, etc.

There are global variables that can be accessed from any <DECLARE> or <EXECUTE>, and any
changes to those variables are kept. These globals can hold just about any kind of data.

RandomValue

The "RandomValue" variable is read-only. RandomValue is a random floating-point value where:
0 < RandomValue < 1

This variable is provided because the random functions of some scripting languages are inadequate.

Creating Simple Templates

Any loose-leaf entry can be a simple template.

Creating a Simple Template

Here are the steps to create a simple template:

1. Create a loose-leaf entry to be the template (Entry menu, Create New Entry sub-menu,
Document). The "Templates" category can be used for this, or any other loose-leaf/notebook category

you choose. Name the entry "My Template".

2. Enter the text to use for the template. Here is some example template text (between the "- - - - - "):
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Today I accomplished:

This made me happy today:

This made me angry today:

3. Now, to mark the entry as a template, click on the Entry menu, and choose Template Entry. The
entry's icon in the entry tree will now show a red "T" (&).

Using "My Template"

1. Bring up the current date in your "Daily Journal" category, and scroll to the end of the entry, if
necessary.

2. Click on the Insert menu, and bring up the Insert Template sub-menu. Choose "My Template”.
This will insert the text of "My Template" into the active entry.

4.16.7 Creating Enhanced Templates

4.16.7.1 Creating Enhanced Templates Overview

This section will provide a short tutorial in creating enhanced templates.

Like a simple template, an enhanced template must be a loose-leaf/notebook entry. However, while a
simple template consists of whatever text is in its entry, an enhanced template must be properly
structured using the enhanced template tags.

An enhanced template can have one or more "sections", any one of which can be chosen when the
template is inserted. A specific section can be chosen, or one can be chosen at random, or in
sequence, depending on how the enhanced template is used.

Enhanced templates can "include" sections from other templates or even other entries in other
categories. Combined with the ability to execute ActiveScript scripting commands, enhanced templates
are a powerful feature of The Journal.

In the "Templates" category that is created for you automatically, there are a small number of
enhanced templates. Those provide some examples of what can be done. Feel free to refer to those
as you read on, to see how they work and how they are structured.

Next: Enhanced Template Basics

4.16.7.2 Enhanced Template Basics

Enhanced templates use HTML- and XML-style "tags". These tags define the template itself, the
sections within the template, and handle scripting. The following example shows the simplest form of
an enhanced template:

<TEMPLATE>
<SECTION>Template text is here, as a section.</SECTION>
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</TEMPLATE>
The <TEMPLATE> and <SECTION> Tags

As you can see in the example above, an enhanced template begins with a <TEMPLATE> tag, and
ends with a <ITEMPLATE>. The <TEMPLATE> must be the first text in the entry. Any text that follows
the </TEMPLATE tag is ignored.

The <SECTION> and </SECTION> tags mark the actual text to provide when the template is inserted.
If you were to create an enhanced template from the above example, when you inserted the template,
you would get:

Template text is here, as a section.
This may seem like a long way around to get to something that can be easily handled with

simple templates--and it is. So now we will talk about a couple useful things you can do with enhanced
templates.

Some Useful Tags: <DATE/> and <TIME/>

Suppose you want a way to quickly log when you eat, and what you eat. You don't want to create a
whole new category for this, preferring to just enter the information in your normal "Daily Journal”
entries. Here's a template that you can insert when you need it:

<TEMPLATE>

<SECTION>

Food Log for <DATE FORMAT="mm/dd/yy"/> @ <TIME FORMAT="hh:nn">
Food/Description Servings Calories

</SECTION>

</TEMPLATE>

When you insert this template, the <DATE/> tag will be replaced with the current date, using the format
specified, and the <TIME/> tag will be replaced with the current time, again using the format specified.
Here's an example:

Food Log for 06/03/03 @ 07:47pm
Food/Description Servings Calories

Then you could type in the name of the food you ate, and then tab over to fill in the number of servings
and the calories.

The "FORMAT=..." part of the tags is called an attribute. Attributes usually take the form of:
ATTRIBUTENAME="Attribute Value"

That is, the name of the attribute is specified in all caps, followed by an equal sign (=), and then the
value of the attribute, enclosed in double quotes.

To see all of the available FORMAT options for <DATE/> and <TIME/>, click here.

NOTE: Typically, tags and attributes are entered in ALL CAPS, but this is only a convention. Enhanced
template tabs and attributes can be either lowercase, UPPERCASE, or MixedCase.

Next: Enhanced Template Sections Part 1
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4.16.7.3 Enhanced Template Sections

You have been shown the basic structure of an enhanced template, using
<TEMPLATE></TEMPLATE> and <SECTION></SECTION pairs, and even how to use attributes to
modify a tag like <DATE/>. We will now talk about enhanced template sections in more detail.

Multiple Sections

As we have already covered, the <SECTION> and </SECTION> tags mark the actual text to provide
when the template is inserted. Unlike a simple template, however, where the entire entry is used every
time, an enhanced template can have more than one section, and which one is used can be
determined a couple of different ways. For example:

<TEMPLATE METHOD="random">

<SECTION>How are you today?</SECTION>
<SECTION>What's up?</SECTION>

<SECTION>How are you feeling today?</SECTION>
<SECTION>Have you won the lottery yet?</SECTION>
<SECTION>Do you know where your towel is?</SECTION>
<SECTION>What's the weather like?</SECTION>
<SECTION>How is work?</SECTION>

</TEMPLATE>

This enhanced template, when inserted, will randomly choose from one of the above questions. Only
one of them will be used each time the template is inserted.

Note the METHOD attribute of the <TEMPLATE> tag. This attribute specifies how the template will
choose from the available sections. There are two possible METHOD's:

random Choose a random section
sequence Choose the next section in sequence

If the METHOD attribute had been set to "sequence" instead of "random”, then the first time you
inserted the template, you would get:

How are you today?
The second time you would get:
What's up?
And so on. The sequence will repeat once it reaches the last available section.

While the example given is somewhat contrived, it's not too different from the various Writing Prompt
templates in the "Templates" category.

Section Formatting

A section will pull the text, with whatever font or formatting it may have, from the end of the
<SECTION> tag to the beginning of the </SECTION> tag. So if the section text has bold, or italic, or

even different fFomnts, this will be inserted, as well. This includes paragraph formatting, like
indentation and hard returns.

The example above, with the different greetings, for instance, will insert the greeting at the current
cursor position in the active entry. Afterward, the cursor will be position immediately after the last
character in the greeting. If, instead, you wanted a blank line after the greeting, you would need to add
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that to the section, like this:

!SECTION>How are you today?
</SECTION>

If you wanted two blank lines after the greeting, you would do this:

!SECTION>How are you today?
</SECTION>

And, maybe you want a blank line before the greeting, to separate it from the preceding text. In which
case, you would do this:

<SECTION>
How are you today?

</SECTION>

You can override the formatting of a section if use the UNFORMATTED attribute of the <TEMPLATE>
tag. This will force the text of the section to be treated as simple text, with no formatting such bold,
italic, or whatever. Paragraph formatting will also be stripped off, though not hard returns/line breaks
used to separate paragraphs. This is how the above example would be changed:

<TEMPLATE METHOD="random" UNFORMATTED>

Next: Enhanced Template Scripting

Enhanced Template Scripting

With an understanding of enhanced template sections, we now turn our attention to one of the more
powerful aspects of enhanced templates: scripting. With scripting, you can create sophisticated
functions and use them when processing the enhanced template.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows
how scripting can be used in The Journal.

Enhanced templates can use ActiveScript languages such as VBScript, JavaScript, and so on. Any
ActiveScript language that is installed on your computer can be used.

Within a Section or Outside of a Section

Scripts in enhanced templates can be either inside of a section (between the <SECTION></SECTION>
tags) or outside of any section. The biggest difference between those two cases is:

1. Script within a section is only executed when that section is selected. The results of the script, if any,
may be added to the text of the section when it is inserted into the active entry.

2. Script that is external to any section is executed every time the enhanced template is processed,
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before any section is selected.

The <EXECUTE> Tag

Script commands are always bracketed by the <EXECUTE> tag, and it's trailing </[EXECUTE>.
Everything between those tags is considered to be part of the script.

The default scripting language is VBScript. You can override this with the USE attribute. For example:
<EXECUTE USE="JavaScript">
/I JavaScript commands here...
</EXECUTE>

If you specifiy a language with the USE attribute, that language must be available. Otherwise, the script
will not run. For simplicity, VBScript will be used in the examples given in the rest of this tutorial.

Global Script Variables

For script that is executed outside of a section, the only way to hold onto any results is with the global
variables provided.

There 1000 global variables available, and they can contain just about any type of value you choose
(number, string, etc.). You access them within your script commands like so:

<EXECUTE>
élobalnn='This String'
</EXECUTE>

Or:
<EXECUTE>
i'f.GIobaInn>=18 then
</EXECUTE>

Where "nn" is some number from 1-1000. Thus, you could have "Global1" or "Global23" or "Global456"
and so on.

The Result Variable

The Result variable is a local variable available only to <EXECUTE>'s that are inside of a section. The
Result variable can be assigned a value, either a string value or any value that can be easily converted
to a string (like a number). The value of Result is then inserted into the section's text, replacing the
entire <EXECUTE> </EXECUTE> script.

For example, this section:
<SECTION>
Hello, my name is <EXECUTE>Result="David"</EXECUTE>!
</SECTION>

Would look like this when inserted:

Hello, my name is David!
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That's not a very sophisticated example, though. So let's try something a bit more complicated.

An Example with Scripting
Let's say you want a simple writing exercise that uses a random letter. You could do it like this:
<TEMPLATE>

<EXECUTE>

if Int(RandomValue*2)>0 then
Global1="begins"

else
Global1="ends"

end if

</EXECUTE>

<EXECUTE>

Global2=Chr(65+Int(RandomValue*26))

</EXECUTE>

<SECTION>

Write about a word that <EXECUTE>Result=Global1</EXECUTE> with the letter:

<EXECUTE>Result=Global2</EXECUTE>

</SECTION>

</TEMPLATE>
This template randomly selects either "begins" or "ends", and then randomly selects a letter from A-Z.
These values are stored in the global variables Global1 and Global2, respectively. The section then
combines those variables with some text to create the writing exercise. Examples of the templates
output are:

Write about a word that ends with the letter: X

Write about a word that begins with the letter: E

The "RandomValue" variable used in the above scripts is a global variable available in enhanced
templates. It returns a random value (x) where: 0 <x <1

Next: Enhanced Template Scripting Part 2

Enhanced Template Scripting Part 2

Even with only what we've shown you so far, scripting is obviously a powerful feature. There is more,
however. In this topic, we discuss two more tags that take scripting to the next level.

Warning: This discussion of scripting in enhanced templates assumes that you are familiar with basic
programming techniques. This is not a tutorial about any particular scripting language. It only shows
how scripting can be used in The Journal.

The <DECLARE> Tag

The <DECLARE> tag is much like the <EXECUTE> tag, in that it contains script code. Unlike the script
in <EXECUTE>'s, however, script in <DECLARE>'s is not run. Instead, the procedures and functions
declared are available to be called from within a <EXECUTE>.
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You can have more than one <DECLARE></DECLARE> in an enhanced template. If you do have
more than one, they are consolidated and treated as a single collection.

One example of using <DECLARE> comes from role-playing games (RPG's). In RPG's many things
are based on the roll of a die. The die can have 4 sides (a d4), 6 sides (a d6), 8 sides (a d8), and so
on. If you wanted to create a template that would generate RPG items, you would be calculating
random numbers frequently. Rather than duplicate that script every time you need it, it is more useful
to create it once:

<TEMPLATE>

<DECLARE>

function RollDie(typeDie)
RollDie=Int(RandomValue*typeDie)+1

end function

function RollDice(typeDie,count)
total=0
for dd=1 to count

total=total+RolIDie(typeDie)

next
RollDice=total

end function

</DECLARE>

<SECTION>You find <EXECUTE>Result=RolIDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RolIDice(6,3)</EXECUTE> silver coins.</SECTION>
</TEMPLATE>

So now you can create a collection of common function and procedures with your enhanced template.
But what if you want to use the same collection in other enhanced templates?

The <INCLUDE> Tag

The <INCLUDE> tag allows you to access entries within The Journal, or even files outside of The
Journal, and "include" them as part of the enhanced template.

Thus, you could create a loose-leaf entry called "Dice Functions" that contains this:

<DECLARE>

function RollDie(typeDie)
RollDie=Int(RandomValue*typeDie)+1

end function

function RollDice(typeDie,count)
total=0
for dd=1 to count

total=total+RollDie(typeDie)

next
RollDice=total

end function

</DECLARE>

Then you could simple "include" that entry in those enhanced templates where you need those
functions:

<TEMPLATE>
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<INCLUDE ENTRY="Dice Functions">
<SECTION>You find <EXECUTE>Result=RolIDie(6)</EXECUTE> gold dubloons and
<EXECUTE>Result=RollDice(6,3)</EXECUTE> silver coins.</SECTION>
</TEMPLATE>

Much more compact, and much easier to maintain.

Next: Enhanced Templates Wrapup

4.16.7.6 Enhanced Templates Wrapup

Hopefully this short tutorial has shown you some of what is possible with The Journal's enhanced
templates.

With multiple sections to provide some variability, and scripting to add power, enhanced templates can
be amazingly versatile and useful.

Again, check out the enhanced templates that are provided in the "Templates" category. See how they
do what they do, and feel free to tinker with them.

Learn more here:

Enhanced Template Tags
Enhanced Template Script Variables

417 Topics
4171 Topics

Topics provide another powerful way to organize your throughts in The Journal. You can set a topic to
the text of entry, either as you type it or afterward. You can set as many topics within an entry as you
wish. You can then search entries with a topic or topics and review them. Searching by topic can be a
lot faster than searching for a word, phrase, or collection of words.

The Journal creates a list of more than 60 topics and sub-topics for you, including:
Business

Dream: Themes

Family: Parents

Feelings

Finances: Income

Friends

Health

Hobbies

And more!

Of course, you can add topics of your own and delete the ones you don't need.

Each topic can be given its own highlight color, to make it easier to see, and you can assign hot-keys
to up to 10 topics for ease of use.

When reviewing your entries, topics can be displayed (either one at a time or all at once) or hidden
entirely.
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4.17.2

417.3

Using Topics
Editing Topics
Searching Topics

Using Topics
You can use topics either as you type in your entries, or apply them afterward as you review your entry.
Using Topics while Making Your Entry

Select the topic you want from the drop-down list on the toolbar (above the calendar). Once you do
that, whatever you type will be automatically assigned that topic.

You can switch to a new topic (or no topic) at any time by selecting the appropriate choice from the

topic list. The hot-key for "Apply <No Topic>" is: Shift+Ctrl+<spacebar> Also, if you double-space after
a paragraph (hit ENTER twice), then you turn off the active topic.

Applying Topics to Your Entry

You can also apply topics to text after you enter it. Select the text you want to tie to the topic, then
choose the topic from the list.

A given block of text can have any number of topics assigned to it. The marked text will show up in
searches for any of the applied topics.

Viewing Topics

When you review entries with topics, you have these options:

¢ Show No Topics - all topic highlights are turned off

e Show All Topics - all topic highlights are turned on

e Show <topic> - only the highlight for the selected topic is shown, making it easy to see where that
topic has been set

Editing Topics

The Journal creates a list of more than 60 topics and sub-topics for you, but you can change the topics,
delete topics you don't need, and add topics of your own.

To edit your topics, click on the "Topics" menu and choose "Edit Topics..."

Any topic that you have used is shown as bold in the list of topics.

Topic Name
Every topic must have a unique name.

By convention, topics are named with this format:
Topic: Sub-topic

You don't have to name your topics this way, of course.

NOTE: If you change the name of a topic that you have used in an entry, you may not be able to
search on that topic.

Highlight
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4.17.4

418
4.18.1

4.18.2

To make it easier to distinguish topics used in an entry, you can set the highlight color. If you do not set
a color, then the default topic highlight color is used.

Hot-Key

Up to 10 topics can be assigned a hot-key. Giving a topic a hot-key makes it even easier to apply that
topic. The available hot-keys are Shift+Ctrl+1, Shift+Ctrl+2, up to Shift+Ctri+0.

Delete Topic
NOTE: If you delete a topic that you have used in an entry, you will not be able to search on that topic.

Searching Topics

Searching by topic can be a lot faster than searching for a particular word or phrase. Because an entry
knows which topics have been used, it does not have to examine the entire entry.

To search by topic:

1. Click on the "Search" menu and choose "Search Entries..." (hot-key: Shift+Ctrl+F).

2. Click on the "Search Topics" tab.

3. Check the topic(s) you want to search for. NOTE: The topics you have used at least once in an entry
are listed first, in alphabetical order. All other topics are listed in alphabetical order following the ones
you have used.

4.Click on "Search".

User Interface

Customizing the Menus & Toolbars

The Journal supports full customization of the main menu and all toolbars. Each user of The Journal
can have her own settings.

Right-click on the menu or toolbar that you want to customize, and choose Customize. This will open
up a form which contains all available menu and toolbar commands.

Drag the commands you want and drop them on the menu or toolbar where you want them.

Keyboard Shortcuts (Hot-Keys)

Ctrl-Tab Move to next category tab
Ctrl-Shift-Tab  Move to previous category tab

F1 Context-sensitive help

Shift-F1 "What's This" help

F2 Rename selected entry

Ctrl+F2 Add a Calendar Charm to selected entry

F3 Repeat last find

F4 Editing toggle for Read Only entries

F5 Go to today's entry in category (Standard Categories only)
Ctrl-F5 Go to date (Standard Categories only)

F6 Set date for all active categories (Standard Categories only)
F7 Go to previous entry in category

Shift-F7 Go back 1 month (Standard Categories only)
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Ctrl-F7
F8
Shift-F8
Ctrl-F8
F9
Shift-F9
F10

Ctrl-F
Ctrl+Shift-F
Ctrl-G

Go back 1 year (Standard Categories only)

Go to next entry in category

Go forward 1 month (Standard Categories only)
Go forward 1 year (Standard Categories only)
Create new entry (Loose-leaf Categories only)
Create new root entry (Loose-leaf Categories only)
Create new sub-entry (Loose-leaf Categories only)

Find text in entry
Search entries
Replace text in entry

Ctrl-<spacebar>Apply default text style to selected text

Ctrl-Shift-<spacebar>

Ctrl-Delete
Ctrl-B
Ctrl-U

Ctri-l
Ctrl-<dash>
Ctrl-[

Ctrl-]

Ctrl-M
Ctrl-Shift-M
Ctrl-H
Ctrl-Shift-L
Ctrl-Shift-N
Shift-F10
Ctrl-Shift-D
Ctrl-L
Ctrl-R
Ctrl-E
Ctrl-K

Ctrl-D
Ctrl-T
Ctrl-Shift-1

Ctrl-Shift-<dash>

Ctrl-J
Ctrl+Alt+J

Ctrl+Shift+J
Ctrl+Shift+U

Ctrl-Shift-T
Ctrl-Shift-E
Ctrl-Alt-C
Ctrl-Alt-T
Ctrl-Alt-1

Alt-Up
Alt-Down
Alt-Shift-Up

Ctrl-Zz
Ctrl-Y

Set selected text to "<No Topic>"
Delete word

Toggle Bold On/Off

Toggle Underline On/Off

Toggle Italics On/Off

Toggle Strikeout On/Off

-1 font size

+1 font size

Indent paragraph

Unindent paragraph

Hanging indent

Toggle bulleting

Toggle numbering

Bring up entry context menu

Add/edit description of selected image
Align paragraph left

Align paragraph right

Center paragraph

Block justify paragraph

Insert Current Date at cursor

Insert Current Time at cursor

Insert Current Timer at cursor
Insert line at cursor

Hide (and optionally Lock) Journal
Activate The Journal (if running)

Open Journal Volume
Switch user (login in as a different user)

Shift focus to date tree

Shift focus to entry

Toggle calendar On/Off

Toggle date tree On/Off

Toggle countdown timer and stopwatch On/Off

Move Entry Up
Move Entry Down
Promote Entry

Undo changes
Redo changes
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4.18.3

4.18.4

Journal.INI

The Journal's creates a "Journal.INI" file in The Journal's installed folder. This file is created the first
time The Journal is run.

[GlobalOption]
The [GlobalOption] section provides access to the following settings:
GOShowSplashScreen

If true (=1), show the "splash screen" when starting The Journal. If false (=0), do not show the "splash
screen" when starting The Journal.

GOForceRepair

If true (=1), force The Journal to repair both the System Database and all Journal Volumes. This option
is automatically reset to false (=0) after the forced repair is completed.

GOlnterfaceFontSize

If set to any positive value, that value is used as the font point size used in the entry date tree and
category tabs.

The default font point size is 8. If you would like to increase the font size used, try:
GOlnterfaceFontSize=10

GONoCtrlAltHotKeys

If true (=1), this option turns off the keyboard shortcuts in The Journal that use Ctrl+Alt key
combinations. Currently, this only affects the Toggle Calendar (Ctrl+Alt+C) and Toggle Tree
(Ctrl+Alt+T) hot-keys.

Some international users (e.g., from Poland) were having problems with the Ctrl+Alt+C hot-key. It
prevented them from using a particular accented character.

GOFileMenuOverride

If true (=1), changes the name of the "Journal" menu to the more traditional "File". This also has the
effect of changing the shortcut key for the "Format" menu from "F" to "R".

Command Line Options

-v Specify Journal Volume

You can specify a Journal Volume to open when you start The Journal. The format is:
journal.exe -v VolumeName

Example: journal.exe -v Home

If the Journal Volume name includes spaces, then the name must be in quotes.

Example: journal.exe -v "Volume 1"
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4.18.5 Miscellaneous Forms
4.18.5.1 Calendar Charms

To choose a Calendar Charm:
1. Select the Calendar Charm Collection.
2. Click on the Charm you want, by clicking on it or using the arrow keys.

3. Click on Select.

To Remove a Calendar Charm:
1. Click on Clear.
2. Click on Done.

See also: Calendar Charms

4.18.5.2 Category Statistics

This form shows the following information for the active category:

# of Entries - the total number of entries in this category

Security Level - whether the category requires a password or not

Shared? - whether the category is shared; if so, whether it's shared read only or full access
Read Only? - whether the category is read only (no new entries, no editing of entries)
Parent Category - the name of the category's Master Category, if any

4.18.5.3 Choose Category to Import Into

When importing entries from a JNX export file, if you have specified Confirm All Import Categories in
User Preferences: Import, then you will be prompted to choose the correct category to use for the
import.

You can only choose a category that is the same type (standard or loose-leaf) as the category that is
being imported.

You can also create a new category to receive the import, or you can tell The Journal to auto-create
the category.

4.18.5.4 Clipboard Viewer

The Journal's Clipboard Viewer provides a powerful tool for managing and using the Windows
clipboard. You can edit the clipboard contents, or paste them into the currently active entry.

With the "Auto-Paste to Active Entry" option, you can have anything that is copied to the Windows
clipboard automatically pasted into the active entry. This means you can rapidly collect information
from various applications and web pages without having to switch back and forth between The Journal
and the source of the information. Just select what you want, and copy it to the clipboard.

4.18.5.5 Countdown Timer

The Journal's countdown timer can be used in a variety of ways:
¢ Many writing and journaling exercises want you to "just write" for a set period of time, like 10
minutes.
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4.18.5.6

4.18.5.7

o For your current writing project, you want to write for an hour every day.
o For any project where you want to work for a period of time, the countdown timer can be set for a
matter of seconds, or even hours.

To use the countdown timer, click on the Options menu and check Show/Hide Timer (hot-key:
CtrI+Alt+l). There is also a stopwatch button on the toolbar that does the same thing.

NOTE: When you use the countdown timer, the stopwatch is disabled. And vice versa. You cannot use
both the countdown timer and the stopwatch at the same time.

Time Remaining

You can set the countdown timer to any time from just 1 second to many hours. You type in the
duration you want, and hit ENTER.

Setting durations:

mm Will set the timer for mm minutes.

sS Will set the timer for ss seconds.

mm:ss Will set the timer for mm minutes and ss seconds.

hh:mm:ss Will set the timer for hh hours and mm minutes and ss seconds.

While the timer is counting down, you can insert the current timer value into your entry by clicking on
the Insert menu and choosing Insert Timer Count.

When the timer reaches 00:00:00, a sound is played to alert you. You can set the sound in
User Preferences.

Start

Will start the countdown timer. If you have paused the timer, it will resume from its last count.
Pause

Will pause the countdown timer.

Reset

Reset stops the countdown timer, resetting it to 00:00:00.

Delete Users

You can only delete users within the active Journal Volume.

NOTE: Deleting a user also deletes all categories and entries for that user. Once deleted, a user
cannot be recovered.

Edit Auto Replace Strings

You can use the auto-replace feature to simplify your typing. You can create simple strings that are
automatically replaced with more complex text as you type them.

Auto-Replace Strings

This is the list of all auto-replace strings you have created. To edit an auto-replace string, click on it in
the list. To create a new auto-replace string, click on New Auto-Replace.
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Replace

This is the sequence of characters that is to be replaced with the text in With. Each replacement string
must be unique.

With

This is the text that is automatically inserted when you type the string in Replace within an entry. This
text can be one or more lines long, and can be either formatted or unformatted.

Use Formatting
Check this option to apply formatting to the With text.
4.18.5.8 Edit Header/Footer

This form is used to edit both headers and footers for users and categories.

Headers and footers are functionally identical, and are configured using the same options. The only
difference between them is that one is printed at the top of the page (headers) and one at the bottom
of the page (footers).

Formatted text can be used in both headers and footers. This means you can use any TrueType font
you have on your PC, you can use bold, jtalic, etc., and you can specify that the text be aligned to the
left, right, or centered. An empty header or footer will not be printed.

With the use of Print Macros, the text of the header and footer can include pre-defined values such as
the page number, the category name, and so on.

See User Preferences: Printing and Printing Headers and Footers for more information.

4.18.5.9 Edit Symbol Replace Strings
Some symbols are awkward, if not impossible, to type using normal keyboards. The Journal's Symbol

Replace feature can help work around this limitation by associating simple sequences with special
characters.

Examples:
(c): ©
(tm) : ™
'e:é
-):©

To create a new Symbol Replace sequence, simply click on New. Then type in the sequence of
characters, choose the font, and choose the symbol.

Replace

This is the sequence of characters that is to be replaced with the symbol. Each replacement string
must be unique.

Symbol Font
This is the Windows TrueType font that contains the desired symbol.

Symbol and WingDings fonts contain many command symbols, such as ¥ and ©
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Special Roman characters, such as é and &, are genearlly supported by any normal Windows
TrueType font (such as Arial). For these characters, it is recommended that you use the "<Default>"
font option.

Symbol

Once you have selected the desired Symbol Font (or <Default>), simply choose the character you
want.

4.18.5.10 Enter Registration Keys

Use this form to enter the Registration Keys you received when you bought The Journal.
The Registration Keys are in the form:

Key 1: YOUR NAME
Key 2: XXODDSTUFFHEREXX

4.18.5.11 Entry Statistics

This form shows the following information for all entries:

Date Created - the date this entry was originally created

Date Last Modified - the date of the last modification to the entry

Date Last Printed - when the entry was last printed

Total Editing Time - the number of minutes spent editing the entry (this is measured as the time
from beginning an addition/modification to the time the entry was saved) *

¢ Revision Number - the number of times the entry has been modified (all changes on a single date
count as 1 revision)

For document entries, it also displays:

Words - how many words are in the entry

Characters (no spaces) - how many non-whitespace characters are in the entry

Characters (with spaces) - how many total characters are in the entry

Paragraphs - the number of individual paragraphs in the entry (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)

* For some entries imported from The Journal 3, the total editing time reported may be incorrect.
4.18.5.12Find Text...

Search for text in the current entry.

To search in multiple entries across categories, use Search Entries instead.
4.18.5.13 Get Web Page

Use this form to GET a page from the Web, with all images, and archive it in the active entry.

While most HTML formatting is supported, some formatting options are not supported (example: CSS
style sheets are not pulled). Also, characters from some languages may not be imported properly (this
will be fixed in a future update).

NOTE: The HTTP GET operation may take a few minutes, as it tries to download all of the images on
the page.
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4.18.5.14 Go to Date
Choose the date you want The Journal's calendar set to.
Type in the date by hand, or use the "drop-down" calendar.

The Journal uses the Windows setting for date format.
4.18.5.15 Handle Dropped File

This form pops up when you drag and drop a Windows file onto an external object entry or an
image entry. Document entries automatically insert all dropped files.

Insert this file into Current Entry

The dropped file will be inserted into the current entry, if possible.
Replace Current Entry with this file

The dropped file will replace the current entry.

Add this file under Current Entry

The dropped file will be added as a sub-entry under the current entry.
Add this file as an Entry

The dropped file is added as an entry at the same level as the current entry.
4.18.5.16 History...
This is a list of all the entries you have opened during this journaling session.

4.18.5.17 Login

This is the primary login form of The Journal. Before you can do anything in The Journal, you have to

login.

If you need to login to another Journal Volume, press Cancel and then choose Open Another Journal

Volume.

User Name

Select your user name from the list of users.
Password

Enter your password.
4.18.5.18 Paragraph
Use this form to edit the settings of the current paragraph (or selected paragraphs).
Alignment
Left - The text of the paragraph is lined up on the left margin.

Center - The text of the paragraph is centered on each line.
Right - The text of the paragraph is lined up on the right margin.
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Block - The text of the paragraph is lined up on both the left and right margins.

Indentation

Indentation is specified in inches or centimeters, depending on whether you use the US or metric
systems. Values can be entered in inches (in), centimeters (cm), or points (pt).

Left - Indentation from the left margin.
Right - Indentation from the right margin.

First Line - Indentation of the first line of the paragraph.
Hanging - Indentation of the lines in the paragraph after the first.

Spacing

Before and After spacing are measured in points (pt), but can also be entered as inches (in) or
centimeters (cm).

Line Spacing - Line spacing is either single (default), 1.5, or double.
Before - Spacing before the paragraph.
After - Spacing after the paragraph.

4.18.5.19 Paragraph Borders & Shading

Use this form to add (or remove) borders and shading to the current paragraph (or all selected
paragraphs).

Color

This is the color of the border drawn around the paragraph.

Width

The width, in screen pixels, of the border lines.

Internal Width

This is the spacing between lines (centers of lines) in the border (for double and triple borders).
Offsets...

You can control the spacing between paragraph contents and border. Larger positive values increase
the spacing. Negative values force border to be inside of paragraph contents.

Border Type

You can set the border to be: no border, a single line border, a double line border, a triple line border, a
double line border with the inner line thicker, or a double line border the outer line thicker.

Fill Color

This is the color of paragraph background.

Padding...

You can control the display of the background colored area relative to paragraph contents (the
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distance between limits of paragraph contents and limits of colored area). Larger positive values
increase the hanging. Negative values force the color to be inside of paragraph contents.

4.18.5.20 Replace Text...

Search and replace text in the current entry.
4.18.5.21 Select Entry

Select the entry you want from the list of active categories and their entries.
4.18.5.22 Stopwatch Timer

The Journal's stopwatch timer can be used to track how long you have been working on a particular
project.

To use the stopwatch, click on the Options menu and check Show/Hide Timer (hot-key: Ctrl+Alt+l).
There is also a stopwatch button on the toolbar that does the same thing.

NOTE: When you use the stopwatch, the countdown timer is disabled. And vice versa. You cannot use
both the countdown timer and the stopwatch at the same time.

Time Elapsed

Time Elapsed displays the time since you started the stopwatch, in hours, minutes, and seconds
(hh:mm:ss).

While the stopwatch is running, you can insert the current elapsed time into your entry by clicking on
the Insert menu and choosing Insert Timer Count.

Start
Will start the stopwatch. If you have paused the timer, it will resume from its last count.

Pause

Will pause the stopwatch.

Reset

Reset stops the stopwatch, resetting it to the starting time (00:00:00).

4.18.5.23 Unlock Form

When The Journal is "locked", either by minimizing or by using the "Hide Journal" hot-key (Ctrl+J), you
must enter your password to regain access.

4.18.5.24 User Statistics

This form shows the following information for the current user:

# of Categories (Active) - how many active categories this user has (includes active sub-categories)
# of Categories (Total) - the total number of categories this user has, active or inactive
# of Entries (Active) - the number of entries in all active categories

[ )
[ )
[ )
o # of Entries (Total) - the number of entries in all categories, active or inactive

© David Michael. All Rights Reserved.



125 The Journal

4.18.5.25Word Count

This form displays the following statistics of document entries:

Words - how many words are in the entry

Characters (no spaces) - how many non-whitespace characters are in the entry

Characters (with spaces) - how many total characters are in the entry

Paragraphs - the number of individual paragraphs in the entry (empty paragraphs are not counted)
Lines - the number lines displayed (this number varies as you resize The Journal)
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Create New Entry in Category 44
Creating a New Category 28
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Creating Entries 25
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Credits 8

customize menus 115
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File Names: Category File Name 76
File Names: Date Format 76
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measurement 68

US 68
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Missed Reminders 88
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